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About this Document
This manual is intended for administrators and users of the 
AXIS 216FD/FD-V/MFD/MFD-V Network Camera, and is 
applicable for software release 4.40 and later. It includes 
instructions for using and managing the camera on your 
network. Previous experience of networking will be of use 
when using this product. Some knowledge of UNIX or 
Linux-based systems may also be beneficial, for developing 
shell scripts and applications. Later versions of this document 
will be posted to the Axis Website, as required. See also the 
product’s online help, available via the Web-based interface.

Safety Notices Used In This Manual
Caution! - Indicates a potential hazard that can damage the 
product.
Important! - Indicates a hazard that can seriously impair 
operation. 
Do not proceed beyond any of the above notices until you 
have fully understood the implications.

Intellectual Property Rights
Axis AB has intellectual property rights relating to 
technology embodied in the product described in this 
document. In particular, and without limitation, these 
intellectual property rights may include one or more of the 
patents listed at http://www.axis.com/patent.htm and one or 
more additional patents or pending patent applications in the 
US and other countries. 

This product contains licensed third-party software. See the 
menu item “About” in the product’s user interface for more 
information.

This product contains source code copyright Apple Computer, 
Inc., under the terms of Apple Public Source License 2.0 (see 
http://www.opensource.apple.com/apsl/).  
The source code is available from: 
http://developer.apple.com/darwin/projects/bonjour/

Legal Considerations
Video and audio surveillance can be prohibited by laws that 
vary from country to country. Check the laws in your local 
region before using this product for surveillance purposes.
This product includes one (1) MPEG-4 decoder license. To 
purchase further licenses, contact your reseller.

Electromagnetic Compatibility (EMC)
This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in accordance 
with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that 
interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct 
the interference by one or more of the following measures: 
Re-orient or relocate the receiving antenna. Increase the 
separation between the equipment and receiver. Connect the 
equipment to an outlet on a different circuit to the receiver. 
Consult your dealer or an experienced radio/TV technician 
for help. Shielded (STP) network cables must be used with 
this unit to ensure compliance with EMC standards. 

USA - This equipment has been tested and found to comply 
with the limits for a Class B computing device pursuant to 
Subpart B of Part 15 of FCC rules, which are designed to 
provide reasonable protection against such interference when 
operated in a commercial environment. Operation of this 
equipment in a residential area is likely to cause interference, 
in which case the user at his/her own expense will be 
required to take whatever measures may be required to 
correct the interference. 
Canada - This Class B digital apparatus complies with Canadian 
ICES-003.

Europe -  This digital equipment fulfills the requirements 
for radiated emission according to limit B of EN55022, and the 
requirements for immunity according to EN55024 residential, 
commercial, and light industry.

Japan - This is a class B product based on the standard of the 
Voluntary Control Council for Interference from Information 
Technology Equipment (VCCI). If this is used near a radio or 
television receiver in a domestic environment, it may cause radio 
interference. Install and use the equipment according to the 
instruction manual. 

Australia - This electronic device meets the requirements of the 
Radio communications (Electromagnetic Compatibility) Standard 
AS/NZS CISPR22:2002. 

Equipment Modifications 
This equipment must be installed and used in strict accordance 
with the instructions given in the user documentation. This 
equipment contains no user-serviceable components. 
Unauthorized equipment changes or modifications will 
invalidate all applicable regulatory certifications and approvals. 

Liability
Every care has been taken in the preparation of this manual. 
Please inform your local Axis office of any inaccuracies or 
omissions. Axis Communications AB cannot be held responsible 
for any technical or typographical errors and reserves the right to 
make changes to the product and manuals without prior notice. 
Axis Communications AB makes no warranty of any kind with 
regard to the material contained within this document, including, 
but not limited to, the implied warranties of merchantability and 
fitness for a particular purpose. Axis Communications AB shall 
not be liable nor responsible for incidental or consequential 
damages in connection with the furnishing, performance or use of 
this material.

Trademark Acknowledgments
Apple, Boa, Bonjour, Ethernet, Internet Explorer, Linux, 
Microsoft, Mozilla, Netscape Navigator, OS/2, Real, QuickTime, 
UNIX, Windows, WWW are registered trademarks of the 
respective holders. Java and all Java-based trademarks and logos 
are trademarks or registered trademarks of Sun Microsystems, Inc. 
in the United States and other countries. Axis Communications 
AB is independent of Sun Microsystems Inc. 
UPnPTM is a certification mark of the UPnPTM Implementers 
Corporation.

Support
Should you require any technical assistance, please contact your 
Axis reseller. If your questions cannot be answered immediately, 
your reseller will forward your queries through the appropriate 
channels to ensure a rapid response. If you are connected to the 
Internet, you can:
• download user documentation and firmware updates
• find answers to resolved problems in the FAQ database. Search 

by product, category, or phrases
• report problems to Axis support by logging in to your private 

support area
• visit Axis Support at www.axis.com/techsup/



Safety Notice - Battery Replacement
The AXIS 216FD/FD-V/MFD/MFD-V uses a 3.0V CR2032 
Lithium battery as the power supply for its internal real-time 
clock (RTC). Under normal conditions this battery will last for 
a minimum of 5 years. Low battery power affects the 
operation of the RTC, causing it to reset at every power-up. A 
log message will appear when the battery needs replacing.

The battery should not be replaced unless required!
If the battery does need replacing, please observe the 
following:
• Danger of Explosion if battery is incorrectly replaced
• Replace only with the same or equivalent battery, as 

recommended by the manufacturer.
Dispose of used batteries according to the manufacturer's 
instructions.

RoHS
This product complies with both the European RoHS 
directive, 2002/95/EC, and the Chinese RoHS regulations, 
ACPEIP.

WEEE Directive
The European Union has enacted a Directive 
2002/96/EC on Waste Electrical and Electronic 
Equipment (WEEE Directive). This directive is 
applicable in the European Union member states.

The WEEE marking on this product (see right) or its 
documentation indicates that the product must not be 
disposed of together with household waste. To prevent 
possible harm to human health and/or the environment, the 
product must be disposed of in an approved and 
environmentally safe recycling process. For further 
information on how to dispose of this product correctly, 
contact the product supplier, or the local authority 
responsible for waste disposal in your area. 

Business users should contact the product supplier for 
information on how to dispose of this product correctly. This 
product should not be mixed with other commercial waste.
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Product overview
This manual applies to the AXIS 216FD, AXIS 216FD-V, 
AXIS 216MFD, and AXIS 216MFD-V Fixed Dome Network 
cameras. The information provided here applies to all four 
models, except where otherwise indicated. 
 

Models
AXIS 216FD - Tamper-resistant Fixed Dome Network Camera

AXIS 216FD-V - Vandal-resistant Fixed Dome Network Camera

AXIS 216MFD - Megapixel Tamper-resistant Fixed Dome Network Camera

AXIS 216MFD-V - Megapixel Vandal-resistant Fixed Dome Network Camera

Description
The AXIS 216FD/FD-V/MFD/MFD-V Fixed Dome Network Camera is a high-performance, 
progressive-scan camera for use in professional surveillance situations. Its discreet, 
compact casing effectively protects against tampering/vandalization. Two-way audio 
support enables communication with visitors or intruders. 

The AXIS 216MFD/MFD-V has 1.3 megapixel resolution allowing the same image to be 
viewed in greater detail, or a larger scene to be viewed at a maintained resolution. AXIS 
216MFD/MFD-V gives more than 3 times better resolution compared to a high-resolution 
analog camera. 

Multi-window motion detection and simultaneous Motion JPEG and MPEG-4 allow for 
optimization both on image quality and bandwidth efficiency. Up to 30 fps in VGA. 

Multi-level password protection, IP-address filtering and HTTPS encryption ensure 
network security. Power over Ethernet reduces cabling and enables centralized power back 
up. Supported by the industry's largest base of surveillance applications, this camera 
constitutes the perfect solution for securing e.g. stores, schools and offices.
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Key features
• Discreet and compact design, effective against tampering/vandalization
• Megapixel resolution in AXIS 216MFD/MFD-V. More than 3 times better resolu-

tion compared to a high-resolution analog camera.
• Superior image quality with progressive scan and 30 frames per second in VGA
• Simultaneous Motion JPEG and MPEG-4 for optimized quality and bandwidth
• Two-way audio support including built-in microphone
• Power over Ethernet for reduced cabling and consolidated power
• Multi-window motion detection with alarm image buffering
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Overview

Network
connector

Serial number (S/N)

Please make a note of the 

The serial number is required 
during the installation.

serial number and retain 
for future reference.

Power

I/O terminal
connector

Dome casing

connector

Camera unit

Power
indicator

Network
indicator

Audio out Audio in

Status
indicator

Microphone 

(LED)

(LED)

(LED)

Control
button

Cover
plates 

and PoE

Microphone - Built-in microphone. This can be disabled by inserting a plug in the 'Audio 
in' connector.

Power Connector - For connection of the PS-H power adapter (included).

I/O Connector - The I/O terminal connector provides the physical interface to one 
transistor output, one digital input and an auxiliary connection point for DC power. For 
more information, see The I/O Terminal Connector, on page 48.

Network Connector - The camera connects to the network via a standard network 
connector. Supporting NWAY, the camera detects the speed of the local network segment 
(10BaseT/100BaseTX Ethernet). Supporting PoE (Power over Ethernet), the camera can be 
powered directly from the network cabling.
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Audio out- Audio output (line level), which can be connected to a public address (PA) 
system or an active speaker with a built-in amplifier. A pair of headphones can also be 
attached. A stereo connector must be used for the audio out.

Audio in - One 3.5mm input for a mono microphone, or for line-in mono signal (left 
channel is used from a stereo signal).

Serial Number Label - The serial number may be required during installation. 

Control Button - Press this button to install using the AXIS Internet Dynamic DNS Service, 
or to restore the factory default settings, as described in Resetting to the Factory Default 
Settings, on page 47.

LED indicators

Network Green Steady for connection to 100 Mbit/s network. Flashes for network activity.
Amber Steady for connection to 10 Mbit/s network. Flashes for network activity.
Unlit No connection. 

Status Green Shows steady green for normal operation.
Note: The Status LED can be configured to be unlit during normal operation, 
or to flash only when the camera is accessed. See the online help files for 
more information. Go to Setup > System Options > LED settings

Amber Steady during startup, reset to factory default or when restoring settings.
Red Slow flash for failed upgrade.

Power Green Normal operation.
Amber Flashes green/amber during firmware upgrade.

LED Color Description
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Accessing the Camera
Before accessing the camera it must be installed. Please see the installation guide supplied 
with your product.

The camera can be used with most standard operating systems and browsers. The 
recommended browser is Microsoft Internet Explorer with Windows, Safari with Macintosh 
and Mozilla with other operating systems. 

Notes: • To view streaming video in Microsoft Internet Explorer, set your browser to allow ActiveX controls and allow the AXIS 
Media Control (AMC) to be installed on your workstation.

• QuickTimeTM and Real PlayerTM are also supported for viewing streaming MPEG-4 video and audio.
• If your workstation restricts the use of additional software components, the camera can be configured to use a Java 

applet for viewing motion JPEG.
• The AXIS 216FD/FD-V/MFD/MFD-V includes one (1) decoder license for viewing MPEG-4 video streams. This is 

automatically installed with AMC. The administrator can disable the installation of the MPEG-4 decoder, to prevent 
unlicensed copies being installed.

Access from a browser 
1. Start a browser (e.g. Internet Explorer, 

Mozilla)

2. Enter the IP address or host name of the camera in the Location/Address field of 
your browser.

To access the camera from a Macintosh computer (Mac OSX), simply click on the 
Bonjour tab and select the AXIS 216FD/AXIS 216MFD from the drop-down list.

3. If this is the first time the camera is accessed, see Setting the Password, on page 
12. Otherwise enter your user name and password, as set by the administrator. 

4. The camera’s Live View page is now displayed in your browser. Note that both 
AXIS 216FD/FD-V models will display in the browser as AXIS 216FD both AXIS 
216MFD/MFD-V will display as AXIS 216MFD., 

The layout of the Live View page may have been customized to specific requirements. Consequently, some of the examples and functions 
featured here may differ from those displayed on your own Live View page.
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Setting the Password
1. When accessing the camera for the first 

time, the ‘Configure Root Password’ 
dialog will be displayed on the screen.

2. Enter a password and then re-enter it, to 
confirm the spelling. Click OK.

3. The ‘Enter Network Password’ dialog 
will appear. Enter the User name: root 
Note: The default administrator user name root is permanent and cannot be 
deleted.

4. Enter the password as set in step 2 above, and click OK. If the password is lost, 
the camera must be reset to the factory default settings. See page 47.

5. If required, click Yes to install the AXIS Media Control (AMC). You will need 
administrator rights on the computer to do this.

Accessing the camera from the Internet
Once connected, the camera is accessible on your local network (LAN). To access the 
camera from the Internet you must configure your broadband router to allow incoming 
data traffic to the camera. To do this, enable the NAT-traversal feature, which will attempt 
to automatically configure the router to allow access to the camera. This is enabled from 
Setup > System Options > Network > TCP/IP Advanced.

For more information, please see NAT traversal (port mapping) for IPv4, on page 41. See 
also the AXIS Internet Dynamic DNS Service at www.axiscam.net or, for Technical notes 
on this and other topics, visit the Axis Support Web at www.axis.com/techsup
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Adjusting the image

Image Focus

Zoom puller

Tilt

screw
adjustment

Tilt

screw
adjustment

pullerbalance 
ring

Locking screw

1. Open the Live View page in the Web interface and make the following adjustments on 
the camera:

2. Loosen the locking screw and tilt adjustment screws.
3. Turn the lens to the desired position.
4. Once satisfied, gently tighten the locking screw and tilt adjustment screws to secure the 

camera’s position.
5. Turn the image balance ring to set the horizontal position.
6. Open the Focus Adjustment page in the Web interface under Basic Configuration > 

Focus and follow the on-screen instructions. Use the image window to adjust the focus 
and zoom.
• To set the focus and zoom, loosen the zoom and focus pullers counterclockwise and 

rotate the rings.
• Lock the focus and zoom pullers in position by rotating the screws clockwise.

Note: Due to the dome’s refraction, the image might appear slightly out of focus once the dome has been 
placed. To compensate, focus on an object slightly closer than the intended area.
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The Live View Page
Depending on whether or not the Live View page has been customized, the buttons 
described below may or may not be visible.

View size buttons are available for Motion JPEG in 216MFD/MFD-V. 
Scale the image to an 800 pixel width and return the image to full 
scale. 

The Video Format drop-down list allows the video format on the Live 
View page to be temporarily changed. 

The Output buttons control the 
output directly from the Live 
View page. These buttons are 
configured under Setup > Live 
View Config > Layout.

Pulse - click this button to activate the 
output for a defined period of time, e.g. 
to switch on a light for 20 seconds.

Active/Inactive - click these buttons to 
manually start and stop a connected 
device, e.g. switch a light on/off.

The Action buttons can trigger an event directly from the Live View page. 
These are configured under Setup > Live View Config > Layout.

The Snapshot button saves a snapshot of the video image currently being 
displayed. Right-click on the video image to save it in JPEG format on your 
computer. This button is primarily intended for use when the AMC viewer 
toolbar is not available.

The AMC viewer toolbar (AXIS Media Control) is available in Microsoft Internet 
Explorer only. It displays the following buttons:

The Play/Stop button starts and stops the live video stream.

The Snapshot button saves a snapshot of the video image currently being 
displayed. The Snapshot function and the target directory for saving snapshots 
can be configured from the AMC Control Applet in the Windows Control Panel 
(Internet Explorer only).
Click the View Full Screen button to make the video image fill the entire 
screen area. No other windows will be visible. Press Esc (Escape) on the 
computer keyboard to exit full screen.
Click the Record button to start an MPEG-4 recording (only available when 
viewing MPEG-4). 
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AMC audio controls

There are audio controls for controlling the client computer’s speaker output. These 
controls are only available when audio is enabled, see AXIS Media Control, on page 19 
and Audio, on page 24.

Click the Speaker and Microphone buttons to switch the sound off and on for 
the speaker and microphone, respectively.  
 

Use the sliders to control the volume on the speaker and 
microphone. The volume can be set between 0 and 100. 

The Buffer slider controls the size of the buffer for audio. A higher 
level will reduce audio break-up, but may introduce a noticeable 
lag in audio transmission. There are four settings i.e. min, low, 
high and max. 

When using Half-duplex mode, this button toggles between allowing you to 
speak and listen. The first icon indicates that you can talk and the speaker 
attached to the camera will play your voice. The second indicates that you will 
hear audio from the camera, but no audio will be sent to any web clients.  

 
When in simplex talk mode, the icon toggles between allowing you to speak and is 
dimmed when you do not want other clients to receive any audio.
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Video Streams
The AXIS 216FD/FD-V/MFD/MFD-V provides several different image and video stream 
formats. The type to use depends on your requirements and on the properties of your 
network. 

The Live View page in the AXIS 216FD/FD-V/MFD/MFD-V provides access to MPEG-4 and 
Motion JPEG video streams, as well as to single JPEG images. Other applications and 
clients can also access these video streams/images directly, without going via the Live 
View page. 

How to stream MPEG-4
This video compression standard makes good use of bandwidth, and can provide 
DVD-quality video streams at less than 1 Mbit/s. Note that the image settings of the 
MPEG-4 stream are the same for all clients.

Deciding on the combination of protocols and methods to use depends on your viewing 
requirements, and on the properties of your network. The available options in AMC are:

Unicast RTP This unicast method (RTP over UDP) 
should be your first consideration for live 
unicast video, especially when it is 
important to always have an up-to-date 
video stream, even if some images are 
dropped. 

Unicasting is used for video-on-demand broadcasting, 
so that there is no video traffic on the network until a 
client connects and requests the stream. 

 
Note that there is a maximum of 10 simultaneous uni-
cast connections.

RTP over RTSP This unicast method (RTP tunneled over 
RTSP) is useful as it is relatively simple to 
configure firewalls to allow RTSP traffic. 

RTP over RTSP over HTTP This unicast method can be used to 
traverse firewalls. Firewalls are com-
monly configured to allow the HTTP pro-
tocol, thus allowing RTP to be tunneled.

Multicast RTP This method (RTP over UDP) should be used for live multicast video. The video stream is always 
up-to-date, even if some images are dropped.

Multicasting provides the most efficient usage of bandwidth when there are large numbers of cli-
ents viewing simultaneously. A multicast broadcast cannot however, pass a network router unless 
the router is configured to allow this. It is thus not possible to multicast over e.g. the Internet.

Note also that all multicast viewers count as one unicast viewer in the maximum total of 10 simul-
taneous connections.

AMC will negotiate with the camera to determine exactly which transport protocol to use 
in the order listed above. This order can be changed and the options disabled, to suit any 
specific requirements.
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Important!

MPEG-4 is licensed technology. The AXIS 216FD/FD-V/MFD/MFD-V includes one 
viewing client license. Installing additional unlicensed copies of the viewing client is 
prohibited. To purchase additional licenses, contact your Axis reseller.

MPEG-4 clients

AXIS Media Control (AMC)

The recommended method of accessing live video 
(MPEG-4 and Motion JPEG) from the AXIS 
216FD/FD-V/MFD/MFD-V is to use the AXIS 
Media Control (AMC) in Microsoft Internet 
Explorer in Windows. 

The AMC control panel can be used to configure 
various video and audio settings. Please see the 
readme file included in the tool for more 
information.

The AMC control panel is automatically installed 
on first use, after which it can be configured.  
Open the AMC Control Panel from:

• Windows Control Panel (from the Start menu)
• Alternatively, right-click the video image in Internet Explorer and click Settings in the 

menu.

QuickTime™ & Real Player™

To access the video stream from e.g. QuickTime™ or Real Player™ the following paths can 
be used:

• rtsp://<ip>/mpeg4/media.amp
• rtsp://<ip>/mpeg4/media.3gp

Notes: • The AXIS 216FD/FD-V/MFD/MFD-V supports QuickTime 6.5.1 (or later) and Real Player 10.5 (or later)
• QuickTime adds latency to the video and audio stream (up to 3 seconds)
• It may be possible to use other players to view the MPEG-4 stream using the paths above, although this is 

not guaranteed by Axis
• <ip> = IP address

Motion JPEG
This format uses standard JPEG still images for the video stream. These images are then 
displayed and updated at a rate sufficient to create a stream that shows constantly updated 
motion. 
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The Motion JPEG stream uses considerable amounts of bandwidth, but provides excellent 
image quality and access to each and every individual image contained in the stream. The 
recommended method of accessing Motion JPEG live video from the AXIS 
216FD/FD-V/MFD/MFD-V is to use the AXIS Media Control (AMC) in Microsoft Internet 
Explorer in Windows.

Note also that multiple clients accessing Motion JPEG streams can use different image 
settings.

Alternative methods of accessing the video stream

Video/images from the AXIS 216FD/FD-V/MFD/MFD-V can also be accessed in the 
following ways:

• Motion JPEG server push (if supported by the client, e.g. Mozilla/Firefox). This option 
maintains an open HTTP connection to the browser and sends data as and when 
required, for as long as required. 

• Still JPEG images in a browser. Enter e.g. the path: 
http://<ip>/axis-cgi/jpg/image.cgi?resolution=320x240

• Windows Media Player. This requires AMC and the MPEG-4 viewing client to be 
installed. The paths that can be used are listed below in the order of preference.

• Unicast via RTP: axrtpu://<ip>/mpeg4/media.amp
• Unicast via RTSP: axrtsp://<ip>/mpeg4/media.amp
• Unicast via RTSP, tunneled via HTTP: axrtsphttp://<ip>/mpeg4/media.amp 
• Multicast: axrtpm://<ip>/mpeg4/media.amp 

 
Note: <ip> = IP address
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Configuration
This section describes how to configure the camera, and is intended for product 
Administrators, who have unrestricted access to all the Setup tools, and Operators, who 
have access to the settings for Video & Image, Audio, Live View Config and Event 
Configuration. 

The camera is configured from Setup, from a standard browser (see Minimum web 
browsing requirements, on page 56).

The descriptions below show examples of the features available in the AXIS 
216FD/FD-V/MFD/MFD-V. For details of each setting, please refer to the online help 
available from the setup tools. Click to access the online help.

Accessing the Setup tools
Follow the instructions below to access the Setup Tools from a browser.

1. Start your browser and enter the IP address or host name of the camera in the 
location/address field.

2. The Live View page is now displayed. Click Setup to display the Setup tools.

AXIS Media Control
The AXIS Media Control (AMC) is installed automatically the first time the camera is 
accessed from Microsoft Internet Explorer. The AMC control panel can be opened by 
right-clicking on the video image in the Live View web page. The AMC control panel can 
be used to configure various video and audio settings. Please see the readme file included 
in the tool for more information.

Setup tools
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Video & Image settings

Image Appearance

Use these settings to change the image as required. The image can be rotated, the image 
resolution and compression can be adjusted, and the white balance can be changed.

Resolution includes wide screen 16:9, partial which stands for partial scan where an image 
is taken from the center region of the sensor for optimal frame rate in Motion 
JPEG/MPEG-4 and full speed which is a partial scan that has been scaled down to give full 
frame rate in Motion JPEG.Please see the online help for further information on these 
settings. 

Text Overlay Settings

Use these settings to include a text, date 
and time overlay. 

The text, date and time overlay is 
included on one line at the top or bottom 
of the video image.

Text, date and 
time overlay
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Video Stream

Define the maximum video stream time per session in seconds, minutes or hours. When 
the set time has expired, a new stream can be started by refreshing the page in the browser. 
For unlimited video stream time, select the Unlimited radio button. Note that the 
maximum video stream time does not apply to clients connecting via multicast.

The frame rate allowed to each viewer can also be limited, to avoid bandwidth problems 
on the network. To allow the highest available frame rate, select the Unlimited radio 
button. 

For a preview of the image before saving, click Test. When satisfied with the settings, click 
Save. Please note that the preview image will be in JPEG format, even though the settings 
are valid both for Motion JPEG and MPEG-4.

Overlay/Mask

The following options are available for overlays and masks: 

• Uploaded image as overlay
• Configurable areas as privacy mask

Uploaded image as overlay is a text and/or a static image superimposed over the video 
image, for extra information.

Configurable areas as privacy mask are configurable areas of solid color that can be used 
to block out certain parts of the video image.

Note: When setting privacy masks in AXIS 216MFD/MFD-V make sure the camera is set for full resolution to 
ensure full coverage of sensitive area.

Advanced - Camera Settings

This page contains settings for fine-tuning the video image. These include the color level, 
brightness, sharpness and exposure control. 

Please see the online help for further information on these settings. 

DC-Iris should always be set to Enabled, except during focusing. DC-Iris is a varifocal lens 
which automatically regulates the amount of light entering the camera.

Low Light Behavior

Low light conditions can reduce image quality and increase bandwidth usage. The Low 
Light Behavior settings define the balance between image quality and frame rate. During 
low light conditions, experiment with the settings Exposure priority, Max exposure time 
and Max gain until you achieve an acceptable image quality at the required frame rate. 
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Exposure priority defines the balance between image quality and the frame rate. Higher 
image quality may reduce frame rate and increase motion blur. A prioritized frame rate 
may instead increase image noise. 

By increasing the Max exposure time the quality of the image will increase, but the frame 
rate will decrease. There may also be an increase of motion blur.

Max gain, measured in decibels (dB), describes the amount of amplification applied to the 
visual information in the image. A high level of amplification will provide viewable images 
in very low light, but will increase image noise.

To prioritize image quality, choose Prioritize image quality from the drop-down box 
Exposure priority, and lower the Max gain. If this does not produce the desired results, 
increase the Max exposure time. 

To instead prioritize frame rate, choose Prioritize frame rate from the drop-down box 
Exposure priority and reduce the Max exposure time to e.g. 1/25s or 1/30s. The image 
will darken considerably, but the frame rate will be maintained. To increase the image 
brightness increase the Max gain, but this will also increase the amount of image noise.

Please refer to the online help for more information .

Advanced - MPEG-4 Settings

GOV Settings

The GOV structure describes the composition of the MPEG-4 video stream. Setting the 
GOV-length to a high value saves considerably on bandwidth. The Cyclic refresh 
parameter gives a smoother bit rate and can be useful if bandwidth is limited.

Bit Rate Control

Limiting the maximum bit rate is a good way of controlling the bandwidth used by the 
MPEG-4 video stream. Leaving the Maximum bit rate as unlimited will provide 
consistently good image quality, but at the expense of increased bandwidth usage 
whenever there is more activity in the image. Limiting the bit rate to a defined value will 
prevent excessive bandwidth usage, but images will be lost when the limit is exceeded.

Note that a maximum bit rate can be used for both variable and constant bit rates.

The bit rate type can be set as Variable Bit Rate (VBR) or Constant Bit Rate (CBR). VBR will 
adjust the bit rate according to the images' complexity, thus using a lot of bandwidth for a 
lot of activity in the image and less for lower activity in the monitored area.

CBR allows you to set a fixed Target bit rate that will consume a predictable amount of 
bandwidth, and which will not change whatever happens in the image.
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As the bit rate would usually need to increase for increased image activity, but in this case 
cannot, the frame rate and image quality will be affected negatively. To go some of the 
way towards compensating for this, it is possible to prioritize either the frame rate or the 
image quality whenever the bit rate would normally need to be increased. Not setting a 
priority means the frame rate and image quality will be affected approximately equally.
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Audio
The AXIS 216FD/FD-V/MFD/MFD-V can transmit audio to other clients using either the 
built-in microphone or a connected external microphone and can play audio received from 
other clients via a connected speaker.

Note: The speaker connected to the audio output must have a built-in amplifier, e.g. PC speakers.

An example using AXIS 216FD/FD-V/MFD/MFD-V cameras to transmit audio and video across the network. 

Audio Settings
This section describes how to configure the basic audio settings for the AXIS 
216FD/FD-V/MFD/MFD-V, e.g. set the communication mode and adjust the sound levels in 
the microphone and speaker connected to the camera. 

Enable Audio

Check this box to enable audio.

Client PC

TCP/IP Network

Internal
microphone

Internal
microphone
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Audio Channels

Audio mode

Half-duplex mode transmits and receives audio in both directions, but only in one 
direction at a time. This means that you must select when to receive or transmit audio with 
the push-to-talk button. To speak, press and hold the button (check that the microphone is 
not muted). When finished speaking, release the button and you will receive audio from 
the other end of the connection.

Note that the push-to-talk button is configured from AMC, see AXIS Media Control, on 
page 19. It is also possible to configure the push-to-talk button so that it toggles between 
speaking and listening modes.

When selecting Simplex - Network Camera speaker only mode, the speaker connected to 
the camera will play audio, but no audio will be transmitted from the camera to other web 
clients. This could be used to e.g. provide spoken instructions to a person seen in the 
camera. This mode requires you to use the push-to-talk button.

Simplex - Network Camera microphone only mode transmits audio only from the AXIS 
216FD/FD-V/MFD/MFD-V to web clients. It will not receive audio from any other web 
clients. This can be used in remote monitoring, web attractions etc., to provide live audio, 
as well as video, of a monitored situation.

When using half-duplex, the Send the sound from the active client to all other clients 
option transmits the audio signal from the client that is talking to all the other clients. 

Audio Input

Audio from an external microphone or a line source can be connected to the Audio in 
connector of the AXIS 216FD/FD-V/MFD/MFD-V. The audio source must be set to 
Microphone or Line depending on the connected device.

Note: To prevent unauthorized listening, the internal microphone can be disabled by inserting a plug in the Audio 
in connector.

The Enable microphone power option provides DC power for an external microphone. If 
using a small electret condenser microphone such as a clip-on mic or a PC microphone, 
this option needs to be enabled. 

Note: To use a high impedance dynamic microphone, DC power should not be enabled. DC power will not harm 
the microphone, but if you are uncertain, try switching it off and on. The default value is DC power enabled. 
To use a professional microphone requiring 48V phantom power, you need an external power supply and 
must use a balanced-unbalanced converter (audio transformer) in between. 

If there are problems with the sound input being too low or high, adjust the input gain for 
the microphone attached to the AXIS 216FD/FD-V/MFD/MFD-V.

Select the desired audio Encoding format, AAC, G711, G726.
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Depending on the selected encoding, set the desired audio quality (Bit rate). The settings 
affect the available bandwidth and the required audio quality.

The AXIS 216FD/FD-V/MFD/MFD-V can be set to trigger an event if the incoming sound 
level rises above, falls below or passes the set value. The Alarm level is set between 
0-100%. 

Audio Output

If the sound from the speaker is too low or high, adjust the output gain for the active 
speaker attached to the AXIS 216FD/FD-V/MFD/MFD-V.

When satisfied with the settings, click Save, or click Reset to revert to the previously saved 
settings.

Note: To receive synchronized video in MPEG-4 and audio, it is recommended that the time settings in the camera 
and client PC are synchronized with an NTP Server. This is enabled in the camera under System Options > 
Date & Time. Please refer to the help pages for more information.
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Live View Config

Layout
These are the tools for deciding the layout of the Live View page. 

The layout can be set in 3 ways:

• Use Axis look - the layout is unchanged.
• Use custom settings - modify the Axis look, with your own colors, images etc. Click the 

Configure button and see Customizing the default page, on page 28.
• Own Home Page - Upload and use your own custom page as the default web page. Click 

the Configure button and see Customizing the default page, on page 28.

The other settings on this page concern which features to include, e.g. action button, 
output button, default video stream and viewer. See page 28 for more information.
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Customizing the default page

The appearance of the default Live 
View page can be customized to suit 
your own requirements, or you can 
upload and use your own home page. 
To upload your own files, click the 
Upload/Remove button and see the 
description below.

 

 

Upload Own Web Files

Your own web files, background 
pictures, etc., must first be uploaded to the camera in order to be available for selection in 
the Custom Settings setup dialog. Once uploaded, the files are shown in the drop-down 
lists.

1. Click the Upload/Remove button.

2. Enter the path to the file, e.g. a file located on your workstation or click the 
Browse button.

3. Select the user level for the uploaded file. Setting the user access level means that 
you have complete control over which pages can be viewed by which users.

4. When the path is shown correctly in the text field, click the Upload button.

All uploaded files are shown in the list in the lower section of the page. To remove a file, 
check the box provided next to it and then click the Remove button.

Unchecking the box for Show setup link will remove the setup link from the product's 
Home Page. The Setup Tools will then only be accessible by entering the full setup address 
into the address/URL field of a browser.

Own Home Page

To use a previously uploaded web page as the default page, check the box, select the page 
from the drop-down list and click OK. 

 

Action Buttons

The manual trigger buttons can be used to manually trigger and stop an event from the 
Live View page. See Event Configuration, on page 31.

If the setup link is hidden, setup can be reached at this url: http://<ip address>/operator/basic.shtml. 
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Enabling the display of the Snapshot button allows users to save a snapshot from the 
video stream by clicking the button. This button is mainly intended for use with browsers 
other than Internet Explorer, or when otherwise not using AXIS Media Control (AMC) to 
view the video stream. AMC (an ActiveX control) for Internet Explorer provides its own 
snapshot button. 

Output Buttons

The output buttons are used to manually activate the output from the Live View page, e.g. 
to switch a light on and off. There are 2 options for how the output is activated:

• The Pulse button activates the output for a defined period
• Active/Inactive displays 2 buttons, one for each action (on/off)

Default Video Format

Select the default video format to use on the Live View page. Checking the box for Show 
video format selection displays a drop-down list on the Live View page allowing you to 
temporarily change the format. 

When using MPEG-4 as the video format, the default viewer is AXIS Media Control with 
Internet Explorer.

Note: It is also possible to view Motion JPEG when MPEG-4 is chosen as default and vice versa.

Default Viewer

From the drop-down lists, select the default method for viewing video images for your 
browser. The camera will attempt to show the video images in the selected video format 
and viewer. If this is not possible, the camera will override the settings and select the best 
available combination.

AMC Recommended viewer in Windows Internet Explorer (MPEG-4 /Motion JPEG).

QuickTime MPEG-4 only.

Java applet A slower imaging alternative to AMC. Requires one of the following installed on the client:

Still image Displays still images only. Hit the Refresh button in your browser to view a new image.

Server Push Recommended viewer for other browsers (Motion JPEG).

QuickTime MPEG-4 only.

Java applet A slower imaging alternative to Server Push (Motion JPEG only).

Still image Displays still images only. Hit the Refresh button in your browser to view a new image.

Check the Show viewer toolbar box to display e.g. the AXIS Media Control (AMC) or the 
QuickTime viewer toolbar under the video image in your browser.

Browser Viewer Description

Windows 
Internet Explorer • JVM (J2SE) 1.4.2 or higher

• JRE (J2SE) 5.0 or higher

Other browsers
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AMC Settings

The administrator can disable the installation of the MPEG-4 decoder included with AMC. 
This is used to prevent the installation of unlicensed copies. Further decoder licenses can 
be purchased from your Axis dealer.

HTML Examples
You can add live video from the AXIS 216FD/FD-V/MFD/MFD-V to your own web site. 
The camera can transmit a Motion JPEG stream to up to 20 simultaneous connections, 
although an administrator can restrict this to fewer. If MPEG-4 is set as video format, 
multicasting is used and the video stream will be available for an unlimited number of 
viewers connected to the parts of the network where multicast is enabled. Please note that 
a separate MPEG-4 license is required for each viewer.

Select the preferred Video Format from the drop down list. The available options are 
Motion JPEG, MPEG-4 using AMC and MPEG-4 using QuickTime.

The Motion JPEG selection has additional settings for Image Type, Image size and other 
optional settings to configure the video stream to suit your Web page.  
Click Update once satisfied. 

The camera generates the required source code for your configuration. Copy this code and 
paste it into your own Web page code.

External Video
The AXIS 216FD/FD-V/MFD/MFD-V can also display video images from other Axis 
network cameras and video servers, directly on the Live View page. These are known as 
External Video sources. Once configured, these external video sources are available from 
the drop-down list on the Live View page.

Click the Add button to open the External Video Source Setup dialog, which is used to 
make all the necessary settings. Enter the IP address or host name of the external video 
source you wish to add. Depending on the external source, select either MPEG-2, MPEG-4 
or Motion JPEG as the type of video stream to receive.

Sequence Mode
The Live View page can be configured to rotate through the internal and selected external 
video sources, in order, or randomly. Select the desired video sources and enter the time in 
seconds to display each source (up to 59 minutes). Click Save.

The Sequence buttons will appear on the Live View page to enable the viewer to start and 
stop the sequence mode.
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Event Configuration
An event in the camera is when an Event Type is activated and causes certain actions to 
be performed. The event type is the set of parameters (or conditions) that specifies how and 
when which actions will be performed. A common event type is when the camera uploads 
images when an alarm occurs. Many event types use an Event Server, to receive uploaded 
images.

This section describes how to set up event servers and event types, i.e. how to configure the 
camera to perform certain actions when events (e.g. alarms) occur.

Definitions

A set of parameters describing how and when the camera will perform certain actions

The circumstances that start an event. E.g. on a signal from an external device, such as a 
door switch or a motion sensor.

The circumstances that start an event. E.g. at a pre-programmed time.

What occurs when the event triggers. E.g. the upload of images to an FTP server, e-mail 
notification, etc.

Event Servers
Event Servers are used to receive e.g. uploaded image files and/or notification messages. To 
set up Event server connections in your camera, go to Setup > Event Configuration > 
Event Servers and enter the required information for the required server type.

For details on each setting, please see the online help  available from each web page.

When the setup is complete, the connection can be tested by clicking the Test button (the 
connection test takes approximately 10 seconds). 

Event type

Triggered Event - see page 32

Scheduled Event - see page 33

Action

Server type Purpose Information required

FTP Server • Receives uploaded images • Descriptive name of your choice
• Network address (IP address or host name)
• User Name and Password (for FTP server)
• Upload path e.g. images/
• Port number
• Use passive mode if there is a firewall between the camera 

and FTP server
• Use temporary file if your FTP server doesn’t allow an existing 

file to be overwritten by a new file with the same name

HTTP Server • Receives notification messages
• Receives uploaded images

• Descriptive name of your choice
• URL (IP address or host name)
• User Name and Password (for HTTP server)
• Proxy address/Proxy port (if required)
• Proxy User Name and Password (if required) 

TCP Server • Receives notification messages • Descriptive name of your choice
• Network address (IP address or host name)
• Port number
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Configuring Event Types

An Event Type describes how and when the camera will perform certain actions.

Example: If somebody passes in front 
of the camera and an event that uses 
motion detection has been configured 
to act on this, the camera can e.g. 
record and save images to an FTP server, 
and/or send a notification e-mail to a 
pre-configured e-mail address with a 
pre-configured message. Images can be 
sent as e-mail attachments.

Triggered Event

A Triggered event can be 
activated by e.g:

• a push button connected to the camera’s input port
• detected movement in a configured motion detection window
• a manually activated action, e.g. from an action button in the web interface
• audio that is e.g. louder than a specified level
• on restart (reboot) after e.g. power loss

How to set up a triggered event

This example describes how to set up the camera to upload images when e.g the main door 
is opened:

1. Click Add triggered on the Event types page.

2. Enter a descriptive name for the event, e.g. Main door open.

3. Set the priority - High, Normal or Low (see the online help).

4. Set the Respond to Trigger... parameters for when the event will be active, 
e.g. only after office hours.

5. Select the trigger alternative from the Triggered by... drop-down list, e.g. select 
Input ports, for a sensor connected to the door.

6. Set the When Triggered... parameters, i.e. define what the camera will do if the 
main door is opened e.g., upload images to an FTP server or send an e-mail 
notification.

7. Click OK to save the Event in the Event Types list.

Please see the online help for descriptions of each available option.

Note: Up to 10 event types can be configured in the camera, and up to 3 of these can be configured to upload images. Files 
names can be formatted according to specific requirements. See File Naming & Date/Time Formats online help.
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Pre-trigger and Post-trigger buffers

This function is very useful when checking to see what happened immediately before 
and/or after a trigger, e.g. 30 seconds before and/or after a door was opened. Check the 
Upload images checkbox under Event Types > Add Triggered... > Triggered by... to 
expand the web page with the available options. All uploaded images are JPEG images.

Include pre-trigger buffer - images stored internally in the server from the time 
immediately preceding the trigger. Check the box to enable the pre-trigger buffer, enter the 
desired length of time and specify the required image frequency. 

Include post-trigger buffer - contains images from the time immediately after the trigger. 
Configure as for pre-trigger. 

Notes: •Pre-trigger and Post-trigger buffers will be lost if the connection to the event server fails.

•The maximum length of the pre-/post-buffer depends on the video image size and selected frame rate.

•If the pre- or post-buffer is too large for the camera’s internal memory, the frame rate will be reduced and 
individual images may be missing. If this occurs, an entry will be created in the unit's log file.

Continue image upload (unbuffered) - enables the upload of video images for a fixed 
length of time. Specify the length of time for the uploaded recording, in seconds, minutes 
or hours, or for as long as the trigger is active. Finally, set the desired image frequency to 
the maximum (the maximum available) or to a specified frame rate. The frame rate will be 
the best possible, but might not be as high as specified, especially if uploading via a slow 
connection.

Scheduled Event

A Scheduled event can be activated at preset times, in a repeating pattern on selected 
weekdays.

Configuration example: 

1. Click Add scheduled on the Event types page.

2. Enter a descriptive name for the event, e.g. “Scheduled e-mail upload.”

3. Set the priority (High, Normal or Low).

4. Set the Activation Time parameters (24h clock) when the event will be active, 
e.g. start on Sundays at 13.00 with a duration of 12 hours.

5. Set the When Activated... parameters, i.e. set what the camera will do at the 
specified time, e.g. send uploaded images to an e-mail address.

6. Click OK to save the Event in the Event Types list.

 
Please see the online help for descriptions of each available option.
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Motion Detection
Motion detection is used to generate an alarm whenever movement occurs (or stops) in the 
video image. A total of 10 Include and/or Exclude windows can be configured.

• Included windows target specific areas within the whole video image
• Excluded windows define areas within an Include window that should be ignored 

(areas outside Include windows are automatically ignored)
Once configured, the motion detection windows will appear in the list of available triggers, 
for triggering events. See How to set up a triggered event above.

Note: Using the motion detection feature may decrease the camera’s overall performance.

Configuring Motion Detection

1. Click Motion Detection in the Event Configuration menu.

2. Click the Configure Included Window radio button and click New.

3. Enter a descriptive name under Window name.

4. Adjust the size (drag the bottom right-hand corner) and position (click on the text 
at the top and drag to the desired position).

5. Adjust the Object size, History and Sensitivity profile sliders (see table below for 
details). Any detected motion within an active window is then indicated by red 
peaks in the Activity window (the active window has a red frame).

6. Click Save.

To exclude parts of the Include window, click the Configure Excluded Windows button 
and position the Exclude window as required, within the Include window.
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Please see the online help for descriptions of each available option.

High level Only very large objects 
trigger motion detection

An object that appears in the region will 
trigger the motion detection for a long 
period

Ordinary colored objects on ordinary 
backgrounds will trigger the motion 
detection

Low level Even very small objects 
trigger motion detection

An object that appears in the region will 
trigger motion detection for only a very 
short period

Only very bright objects on a dark back-
ground will trigger motion detection

Default value Low Medium to High Medium to High

Examples: 

• Avoid triggering on small objects in the video image by setting the object size level to high.
• To reduce the number of triggers if there is a lot of movement during a short period of time, select a high 

history level.
• To only detect flashing light, low sensitivity can be selected. In other cases, a high sensitivity level is 

recommended.

Port Status
Under Event Configuration > Port Status there is a list showing the status for the camera’s 
input and output. This is for the benefit of Operators, who have no access to the System 
Options section.

Example: If the Normal state for a push button connected to an input is set to Open circuit - as long as the but-
ton is not pushed, the state is inactive. If the button is pushed, the state of the input changes to active.

 Object Size History Sensitivity
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System Options

Security
User access control is enabled by default. An administrator can set up other users, by 
giving these user names and passwords. It is also possible to allow anonymous viewer 
login, which means that anybody may access the Live View page, as described below:

Users - the user list displays the authorized users and user groups (levels):

Provides the lowest level of access, which only allows access to the Live View page.
An Operator can view the Live View page, create and modify events and adjust certain other 
settings. Operators have no access to the System Options.
An administrator has unrestricted access to the Setup Tools and can determine the registration of 
all other users. 

User Settings - check the relevant checkboxes to enable:

• Anonymous viewer login - allows any viewer direct access to the Live View 
page.

• Maximum number of simultaneous viewers - enter a value here to restrict the 
number of Motion JPEG and MPEG-4 viewers accessing the unit. This is useful if 
you need to save on bandwidth. Note that within the limit of 20 users, all multi-
cast viewers count as 1 viewer.

IP Address Filtering

Enable IP Address Filtering to allow or deny access to the AXIS 216FD/FD-V/MFD/MFD-V. 
Once enabled, the IP addresses in the list will be allowed or denied access according to the 
choice made in the drop-down list Allow/Deny the following IP addresses. 

The administrator can add up to 256 IP address entries to the list (a single entry can 
contain multiple IP addresses). The users from these IP addresses need to be specified in the 
user list with the appropriate access rights. This is done from Setup > System Options > 
Security > Users. 

Referrals

To prevent unauthorized clients from including the video stream from the cameras into 
external Web pages, check the Referrals checkbox and enter the IP address or Host name 
of the computer that hosts the Web pages with the included video stream. Several IP 
addresses/host names can be defined and are separated by semicolons (;). This option is 
only applicable to Motion JPEG video streams.

Viewer

Operator

Administrator
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Notes: •If the referrals feature is enabled and you wish to also allow normal access to the Live View 
page, the product's own IP address or host name must be added to the list of allowed referrers.

•Restricting referrers has no effect on an MPEG-4 video stream. To restrict an MPEG-4 stream, IP 
address filtering must be enabled.

•Restricting referrers is of greatest value when not using IP address filtering. If IP address filter-
ing is used, then the allowed referrers are automatically restricted to those allowed IP 
addresses.

HTTPS

The AXIS 216FD/FD-V/MFD/MFD-V supports encrypted browsing using HTTPS. 

A self-signed certificate can be used until a Certificate Authority-issued certificate has 
been obtained. Click the Create self-signed Certificate button to install a self-signed 
certificate. Although self-signed certificates are free and offer some protection, true 
security will only be implemented after the installation of a signed certificate issued by a 
certificate authority. 

A signed certificate can be obtained from an issuing Certificate Authority by clicking the 
Create Certificate Request button. When the signed certificate is returned, click the Install 
signed certificate button to import the certificate. The properties of any certificate request 
currently resident in the camera or installed can also be viewed by clicking the 
Properties... button. The HTTPS Connection Policy must also be set in the drop-down lists 
to enable HTTPS in the camera.

For more information, please refer to the online help.  

802.1x - Network Admission Control
IEEE 802.1x is an IEEE standard for port-based Network Admission Control. It provides 
authentication to devices attached to a network port (wired or wireless), establishing a 
point-to-point connection, or, if authentication fails, preventing access on that port. 
802.1x is based on EAP (Extensible Authentication Protocol). 

In a 802.1x enabled network switch, clients equipped with the correct software can be 
authenticated and allowed or denied network access at the Ethernet level. 

Clients and servers in an 802.1x network may need to authenticate each other by some 
means. In the Axis implementation this is done with the help of digital certificates 
provided by a Certification Authority. These are then validated by a third-party entity, 
such as a RADIUS server, examples of which are Free Radius and Microsoft Internet 
Authentication Service.

To perform the authentication, the RADIUS server uses various EAP methods/protocols, of 
which there are many. The one used in the Axis implementation is EAP-TLS 
(EAP-Transport Layer Security). 
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The AXIS network video device presents its certificate to the network switch, which in turn 
forwards this to the RADIUS server. The RADIUS server validates or rejects the certificate 
and responds to the switch, and sends its own certificate to the client for validation. The 
switch then allows or denies network access accordingly, on a preconfigured port. 

The authentication process

RADIUS

RADIUS (Remote Authentication Dial In User Service) is an AAA (Authentication, Authori-
zation and Accounting) protocol for applications such as network access or IP mobility. It 
is intended to work in both local and roaming situations.

Protected network

Axis video device

Q: Certificate OK?

Certificate
Authority (CA)

3

1

2

4

A: OK

RADIUS
server

Network
switch

Q: Certificate OK?
A: OK

Certificate

Certificate

1. A CA server provides the required signed certificates.

2. The Axis video device requests access to the protected network at the network switch. 
The switch forwards the video device’s CA certificate to the RADIUS server, which then 
replies to the switch.

3. The switch forwards the RADIUS server’s CA certificate to the video device, which 
also replies to the switch. 

4. The switch keeps track of all responses to the validation requests. If all certificates are 
validated, the Axis video device is allowed access to the protected network via a 
preconfigured port.
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CA servers

In cryptography, a Certification Authority (CA) is an entity that provides signed digital 
certificates for use by other parties, and thus acts a trusted third party. 

There are many commercial CA’s that charge for their services. Institutions and 
governments may have their own CA, and there are free CA’s available. 

Date & Time
Current Server Time - displays the current date and time (24h clock). The time can be 
displayed in 12h clock format in the Overlay (see below).

New Server Time - Select your time zone from the drop-down list. If you want the server 
clock to automatically adjust for daylight savings time, select the Automatically adjust for 
daylight saving time changes. 

From the Time Mode section, select the preferred method to use for setting the time:

• Synchronize with computer time - sets the time from the clock on your 
computer. 

• Synchronize with NTP Server - the camera will obtain the time from an NTP 
server every 60 minutes.

• Set manually - this option allows you to manually set the time and date.

Note: • If using a host name for the NTP server, a DNS server must be configured under TCP/IP settings.  
See Network > TCP/IP below.

Date & Time Format Used in Images - specify the formats for the date and time (12h or 
24h) displayed in the video streams.

Use the predefined formats or use your own custom date and time formats. See Advanced 
File Naming & Date/Time Formats in the online help for information on how to create 
your own file formats.

Network - Basic TCP/IP Settings

IP Address Configuration

The AXIS 216FD/FD-V/MFD/MFD-V supports both IP version 4 and IP version 6. Both 
versions may be enabled simultaneously, and at least one version must always be enabled. 

When using IPv4, the IP address for the camera can be set automatically via DHCP, or a 
static IP address can be set manually. 

If IPv6 is enabled, the AXIS 216FD/FD-V/MFD/MFD-V will receive an IP address according 
to the configuration in the network router.
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There are also options for setting up notification of changes in the IP address, and for 
using the AXIS Internet Dynamic DNS Service. For more information on setting the IP 
address, please see the online help.

Notes: 

• DHCP is a protocol for automatic IP address assignment on a network. IP address assignment via DHCP may 
lead to the situation where the IP address changes and you lose contact with the camera. Configure the 
options for notification of IP address change (under Services) to receive notification from the camera when 
the IP address changes.

• Alternatively, if your DHCP server can update a DNS server, you can access the AXIS 
216FD/FD-V/MFD/MFD-V by host name which is always the same, regardless of the IP address.

Services

Enable ARP/Ping setting of IP address - The IP address can be set using the ARP/Ping 
method, which associates the unit's MAC address with an IP address. Check this box to 
enable the service. Leave disabled to prevent unintentional resetting of the IP address.

Notes: • The ARP/Ping service is automatically disabled 2 minutes after the unit is started, or as soon as an IP address 
is set.

• Pinging the unit will still be possible when this service is disabled.

Options for notification of IP address change - If the IP address for the camera changes, 
e.g. automatically by DHCP, you can choose to be notified of the change. Click Settings... 
and enter the required information.

AXIS Internet Dynamic DNS Service - Use the AXIS Internet Dynamic DNS service to 
assign a host name for easy access to your AXIS 216FD/FD-V/MFD/MFD-V (requires 
Internet access). 

Click Settings... to register the camera with the Axis Internet Dynamic DNS service, or to 
modify the existing settings (requires access to the Internet). The domain name currently 
registered at the Axis Internet Dynamic DNS service for your product can at any time be 
removed.

For more information, please refer to the online help.

Network - Advanced TCP/IP Settings

DNS Configuration

DNS (Domain Name Service) provides the translation of host names to IP addresses on your 
network.

Obtain DNS server address via DHCP - automatically use the DNS server settings provided 
by the DHCP server. Click the View button to see the current settings.
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Use the following DNS server address - enter the desired DNS server by specifying the 
following:

Domain name - enter the domain(s) to search for the host name used by the AXIS 
216FD/FD-V/MFD/MFD-V. Multiple domains can be separated by semicolons (;). The host 
name is always the first part of a Fully Qualified Domain Name, e.g. myserver is the host 
name in the Fully Qualified Domain Name myserver.mycompany.com where 
mycompany.com is the Domain name.

DNS servers - enter the IP addresses of the primary and secondary DNS servers.

NTP Configuration

Obtain NTP server address via DHCP - check this radio button to automatically look up 
and use the NTP server settings as provided by DHCP. Click the View button to see the 
current settings.

Use the following NTP server address - to make manual settings, check this radio button 
and enter the host name or IP address of the NTP server.

Host Name Configuration

The AXIS 216FD/FD-V/MFD/MFD-V can be accessed using a host name, instead of an IP 
address. The host name is usually the same as the assigned DNS Name.

For more information, please see the Security help.

Link-Local IPv4 Address

This is enabled by default and assigns the AXIS 216FD/FD-V/MFD/MFD-V an additional IP 
address for use with UPnP™. The camera can have both a Link-Local IP and a 
static/DHCP-supplied IP address at the same time - these will not affect each other.

HTTP 

The default HTTP port number (80) can be changed to any port within the range 
1024-65535. This is useful for e.g. simple security port mapping.

NAT traversal (port mapping) for IPv4

A broadband router allows devices on a private network (LAN) to share a single connection 
to the Internet. This is done by forwarding network traffic from the private network to the 
“outside” i.e. the Internet. Security on the private network (LAN) is increased since most 
broadband routers are pre-configured to stop any attempts to access the private network 
(LAN) from the public network/Internet.
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Use NAT traversal when your AXIS 216FD/FD-V/MFD/MFD-V is located on an intranet 
(LAN) and you wish to make it available from the other (WAN) side of a NAT router. With 
NAT traversal properly configured, all HTTP traffic to an external HTTP port in the NAT 
router will be forwarded to the camera.

LAN (intranet) WAN (internet)

Broadband 
(NAT)
router

ISP

Notes: • For NAT traversal to work, this must also be supported by the broadband router.
• The broadband router has many different names: “NAT router”, “Network router“, Internet Gateway”, 

“Broadband sharing device” or “Home firewall” but the essential purpose of the device is the same.

Enable/Disable - When enabled, the AXIS 216FD/FD-V/MFD/MFD-V will attempt to 
configure port mapping in a NAT router on your network, using UPnP™. Note that UPnP™ 
must be enabled in the camera (see System Options > Network > UPnP).

Use manually selected NAT router - Select this option to manually select a NAT router 
and enter the IP address for the router in the field provided.

If a router is not manually specified, the AXIS 216FD/FD-V/MFD/MFD-V will 
automatically search for NAT routers on your network. If more than one router is found, 
the default router will be selected.

Alternative HTTP port - Select this option to manually define an external HTTP port. Enter 
the port number in the field provided. If no port is entered here a port number will 
automatically be selected when NAT traversal is enabled. 

Notes: • An alternative HTTP port can be used/be active even if NAT traversal is disabled. This is useful if e.g. your NAT 
router does not support UPnP and you need to manually configure port forwarding in the NAT router.

• If you attempt to manually enter a port that is already in use, another available port will automatically be 
selected.

• When the port is selected automatically it will be displayed in this field. This can be changed by entering a 
new port number and clicking Save.

FTP
The FTP server running in the AXIS 216FD/FD-V/MFD/MFD-V enables the upload of e.g. 
new firmware, user applications, etc. Check the box to enable the service. 
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RTSP

The RTSP protocol allows a connecting client to start an MPEG-4 stream. Check the box to 
enable the server and enter the RTSP port number to use. The default setting is 554. Note 
that MPEG-4 video streams will not be available if this service is not enabled.

Network Traffic

Connection Type - The default setting is Auto-negotiate, which means that the correct 
speed is automatically selected. If necessary, you can set the connection speed by selecting 
it from the drop-down list.

Maximum bandwidth - To minimize the impact on other services running on your 
network, it is possible to configure the maximum network bandwidth the product will be 
allowed to use. Specify the maximum bandwidth (in Mbit/s or kbit/s) allowed, or set to 
Unlimited. 

QoS (Quality of service)
Quality of Service (QoS) provides the means to guarantee a certain level of a specified 
resource to selected traffic on a network. Quality can be defined as e.g. a maintained level 
of bandwidth, low latency, no packet losses, etc. The main benefits of a QoS-aware 
network can be summarized as:

• The ability to prioritize traffic and thus allow critical flows to be served before 
flows with lesser priority.

• Greater reliability in the network, thanks to the control of the amount of band-
width an application may use, and thus control over bandwidth races between 
applications.

The QoS in Axis network video products marks the data packets for various types of 
network traffic originating from the product. This makes it possible for network routers 
and switches to e.g. reserve a fixed amount of bandwidth for these types of traffic. The 
AXIS 216FD/FD-V/MFD/MFD-V marks the following types of traffic:

• video
• audio
• event/alarm
• management network traffic.

QoS Settings  
For each type of network traffic supported by your Axis network video product, enter a 
DSCP (Differentiated Services Codepoint) value. This value is  used to mark the traffic’s IP 
header. When the marked traffic reaches a network router or switch, the DSCP value in the 
IP header tells the router or switch which type of treatment to apply to this  type of traffic, 
for example, how much bandwidth to reserve for it.  
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Note that DSCP values can be entered in decimal or hex form, but saved values are always 
shown in decimal.

For more information on Quality of Service, please see the Axis support web at 
www.axis.com/techsup

SOCKS
SOCKS is a networking proxy protocol. The AXIS 216FD/FD-V/MFD/MFD-V can be 
configured to use a SOCKS server to reach networks on the other side of a firewall/proxy 
server. This functionality is useful if the AXIS 216FD/FD-V/MFD/MFD-V is located on a 
local network behind a firewall, but notifications, uploads, alarms, etc., need to be sent to a 
destination outside the local network (e.g. to the Internet).

SMTP (email)
Enter the host names (or IP addresses) and port numbers for your primary and secondary 
mail servers in the fields provided, to enable the sending of notifications and image email 
messages from the camera to predefined addresses via SMTP.

If your mail server requires authentication, check the box for Use authentication to log in 
to this server and enter the necessary information.

SNMP
The Simple Network Management Protocol (SNMP) allows remote management of network 
devices. Depending on the level of security required, select the version of SNMP to use. The 
three levels of security are:

• SNMP V1 - includes no security.
• SNMP V2c - uses very simple security. The community name can be specified as a pass-

word for read or read/write access to all supported SNMP objects. The community is the 
the group of network devices using SNMP.

• SNMP V3 - provides encryption and secure passwords. HTTPS must be enabled.

UPnP™
The camera includes support for UPnP™, which is enabled by default. If also enabled on 
your computer, the camera will automatically be detected and a new icon will be added to 
“My Network Places.” 

Note: UPnP must also be enabled on your Windows XP computer. To do this, open the Control Panel from the 
Start Menu and select Add/Remove Programs. Select Add/Remove Windows Components and open the 
Networking Services section. Click Details and then select UPnP as the service to add.
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Bonjour
The AXIS 216FD/FD-V/MFD/MFD-V includes support for Bonjour. When enabled, the 
camera is automatically detected by operating systems and clients that support this. 

RTP / MPEG-4
These settings are the port range, IP address, port number (video and audio), and 
Time-To-Live value to use for the video stream(s) in multicast MPEG-4 format. Only 
certain IP addresses and port numbers should be used for multicast streams. For more 
information, please see the online help.

Ports & Devices
I/O Ports - the pinout, interface support and the control and monitoring functions 
provided by this connector are described in The I/O Terminal Connector, on page 48.

LED Settings
The Status indicator LED on the front of the camera can be set to flash at a configurable 
interval (or to not light up at all) whenever the unit is accessed. For a listing of all LED 
behavior, see page 10, or the online help. Note that the LED does not flash when the stream 
is retrieved using MPEG-4 multicast.

Maintenance
• Restart - The camera is restarted without changing any of the settings.
• Restore - The unit is restarted and most current settings are reset to factory default val-

ues. The settings that will not be reset are as follows:
• the boot protocol (DHCP or static)
• the static IP address
• the default router
• the subnet mask

• Default - The default button should be used with caution. Pressing this will return all of 
the camera's settings to the factory default values (including the IP address)

Upgrade Server - See Upgrading the Firmware, on page 50.

Backup - To take a backup of all of the parameters, and any user-defined scripts, click this 
button. If necessary, it will then be possible to return to the previous settings, if settings are 
changed and there is unexpected behavior.

Restore - click the Browse button to locate the saved backup file (see above) and then click 
the Restore button. The settings will be restored to the previous configuration.

Note: Backup and Restore can only be used on the same unit running the same firmware. This feature is not 
intended for the configuration of multiple units or for firmware upgrades.
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Support
The support overview page provides valuable information on troubleshooting and contact 
information, should you require technical assistance.

System Overview - is a quick look over the camera’s status and settings.  Information that 
can be found here includes the camera’s Firmware version, IP address, Security, Event and 
Image settings and Recent log items.  Many of the captions are also links to the proper 
Setup page to conveniently make adjustments in the cameras settings. 

Logs & Reports - when contacting Axis support, please be sure to provide a valid Server 
Report with your query.

Information - Logs, the Server Report and the Parameter List all provide valuable 
information for troubleshooting and when contacting Axis support.

Configuration

Log Level for Log Files - from the drop-down list, select the level of information to be 
added to the Log file

Log Level for Email - from the drop-down list, select the level of information to send as 
email and enter the destination email address.
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Resetting to the Factory Default Settings
To reset the camera to the original factory default settings, go to the System Options > 
Maintenance web page (as described in Maintenance, on page 45) or use the Control 
button on the underside of the camera (see page 9) as described below:

Using the Control Button

To reset the camera to the factory default settings using the Control Button:

Advanced
Scripting is an advanced function that provides the possibility to customize and use 
scripts. This function is a very powerful tool. 

Caution!
Improper use may cause unexpected behavior or even cause loss of contact with the 
unit. If a script does cause problems, reset the unit to its factory default settings. A 
backup file may be of use to return the unit to its latest configuration. 
 
Axis strongly recommends that you do not use this function unless you fully 
understand the consequences. Note that Axis support does not provide assistance for 
problems with customized scripts. 

For more information, please visit the Developer pages at www.axis.com/developer

Plain Config - this function is for the advanced user with experience of Axis network 
camera configuration. All parameters can be set and modified from this page. Help is 
available from the standard help pages.

1. Disconnect the power adapter.

2. Press and hold the Control button while reconnecting the power.

3. Keep the Control button pressed until the Status Indicator color changes to amber 
(this may take up to 15 seconds).

4. Release the Control button.

5. When the Status Indicator changes to Green (which may take up to 1 minute), the 
process is complete and the camera has been reset. The unit will now have the 
default IP address 192.168.0.90
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The I/O Terminal Connector

Pinout and Interface
The 4-pin I/O terminal connector provides the interface to: 

• 1 transistor output
• 1 digital input
• auxiliary power and GND

The terminal connector is used in applications for e.g. motion detection, event triggering, 
time lapse recording, alarm notification via email, image storage to FTP locations, etc.

• Input - for connecting e.g. a push button. If the push button is pressed, the state 
changes and the input becomes active (shown under Event Configuration > Port 
Status).

• Output - connects e.g. an alarm device that can be activated by Output buttons 
on the Live View page, or by an Event Type. The output will show as active 
(Event Configuration > Port Status) if the alarm device is activated.

I/O terminal
connector

I/O terminal connector

Pin Function Description

1 GND
2 3.3V DC Can be used to power auxiliary equipment, max 50mA.

3 Digital Input Connect to GND to activate, or leave floating (or unconnected) to deactivate.
4 Transistor Output With a maximum load of 50mA and a maximum voltage of 24V DC, this out-

put has an open-collector NPN transistor with the emitter connected to the 
GND pin. If used with an external relay, a diode must be connected in parallel 
with the load, for protection against voltage transients.
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Connect input/output devices to the camera as follows:

1. Attach the cables for the device securely to the supplied green connector block.

2. Once the cables are connected, push the connector block into the green terminal 
connector on the camera. 

Terminal Connector

o

AXIS 216FD/FD-V/MFD/MFD-V

3.3V, max. 50mA

e.g pushbutton

4

o3

o

o

2

1
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Troubleshooting

Checking the Firmware
Firmware is software that determines the functionality of the AXIS 
216FD/FD-V/MFD/MFD-V. One of your first actions when troubleshooting a problem 
should be to check the currently installed firmware version. The latest version may contain 
a correction that fixes your particular problem. The current firmware version in your 
camera can be seen on the page Setup > Basic Configuration.

Upgrading the Firmware
When you upgrade the firmware with a file from the Axis Web site, your camera will 
receive the latest available functionality. Always read the upgrade instructions and release 
notes available with each new release, before updating the firmware.

Note: Preconfigured and customized settings will be saved when the firmware is upgraded (providing the fea-
tures are available in the new firmware) although this is not guaranteed by Axis Communications. Always 
read the instructions and release notes available with each new release, before upgrading the firmware.

1. Save the firmware 
file to your 
computer. The latest 
version of the 
firmware is available 
free of charge from 
the Axis Web site at 
www.axis.com/techs
up

2. Go to Setup > 
System Options > 
Maintenance in the 
camera’s Web pages.

3. In the Upgrade Server section, browse to the desired firmware file on your 
computer. Click Upgrade.

Notes: 
 •After starting the upgrade process, always wait at least 5-10 minutes before restarting the 

camera, even if you suspect the upgrade has failed.

•Your dealer reserves the right to charge for any repair attributable to faulty upgrading by the 
user.

•The AXIS Camera Management software tool can be used for multiple upgrades. Please see the 
Axis Web site at www.axis.com for more information.
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Emergency Recovery Procedure
If power or the network connection to the camera is lost during the upgrade, the process 
will fail and the unit will become unresponsive. A flashing red Status LED indicates a failed 
upgrade. To recover the unit, follow the steps below. The serial number is found on the 
label attached to the bottom of the camera.

1. Unix/Linux - From the command line, type the following: 
arp -s <IP address of camera> <Serial number> temp 
ping -s 408 <IP address of camera> 
 
Windows - From a command/DOS prompt, type the following: 
arp -s <IP address of camera> <Serial number> 
ping -l 408 -t <IP address of camera>

2. If the unit does not reply within a few seconds, restart it and wait for a reply. Press 
CTRL+C to stop Ping.

3. Open a browser and type in the camera’s IP address. In the page that appears, use the 
Browse button to select the upgrade file to use, e.g. axis216fd.bin. Then click the Load 
button to restart the upgrade process. 

4. After the upgrade has completed (1-10 minutes), the unit will automatically restart and 
show a steady green on the Power and Status LEDs and flashing green or amber on the 
Network LED. 

5. Referring to the installation guide, reinstall the camera. 

If the emergency recovery procedure does not get the camera up and running again, please 
contact Axis support at www.axis.com/techsup/ 

Axis Support
If you contact Axis support, please help us to help you solve your problems, by providing 
the server report, the log file and a detailed description of the problem.

Server Report - go to Setup > System Options > Support Overview. The server report 
contains important information about the server and its software, as well as a list of the 
current parameters.

The Log file is available from Setup > System Options > Logs & Reports. The Log file 
records events in the unit since the last system restart and can be a useful diagnostic tool 
when troubleshooting.
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Symptoms, Possible Causes and Remedial Actions
Problems setting the IP address

When using ARP/Ping Try the installation again. The IP address must be set within two minutes after power has 
been applied to the camera. Ensure the Ping length is set to 408. See the Installation 
Guide.

The camera is located on a different 
subnet

If the IP address intended for the camera and the IP address of your computer are located 
on different subnets, you will not be able to set the IP address. Contact your network 
administrator to obtain an appropriate IP address.

The IP address is being used by 
another device

Disconnect the camera from the network. Run the Ping command. (In a Command/DOS 
window, type ping and the IP address of the unit). 

If you receive: Reply from <IP address>: bytes = 32; time = 10 ms..... - this means that 
the IP address may already be in use by another device on your network. You must obtain a 
new IP address and reinstall the unit. 

If you see: Request timed out - this means that the IP address is available for use with 
your camera. In this case, check all cabling and reinstall the unit.

Possible IP address conflict with 
another device on the same subnet

The static IP address in the camera is used before the DHCP server sets a a dynamic 
address. This means that if the same default static IP address is also used by another 
device, there may be problems accessing the camera. To avoid this, set the static IP address 
to 0.0.0.0. 

The camera cannot be accessed from a browser
The IP address has been changed by 
DHCP

1) Move the camera to an isolated network or to one with no DHCP or BOOTP server. Set 
the IP address again, using the AXIS IP Utility (see the Installation Guide) or the ARP/Ping 
commands. 
2) Access the unit and disable DHCP in the TCP/IP settings. Return the unit to the main 
network. The unit now has a fixed IP address that will not change. 
3) As an alternative to 2), if dynamic IP address via DHCP or BOOTP is required, select the 
required service and then configure IP address change notification from the network set-
tings. Return the unit to the main network. The unit will now have a dynamic IP address, 
but will notify you if the address changes. 

Other networking problems Test the network cable by connecting it to another network device, then Ping that device 
from your workstation. See the instructions above.

Camera is accessible locally, but not externally
Broadband router configuration To configure your broadband router to allow incoming data traffic to the camera: Enable 

the NAT-traversal feature which will attempt to automatically configure the router to 
allow access to the camera.  
This is enabled from Setup > System Options > Network > TCP/IP Advanced.

Firewall protection Check the Internet firewall with your system administrator.

Default routers required Check if you need to configure the default router settings.

Problems with the MPEG-4 format
No MPEG-4 displayed in the  
client

Check that the correct network interface is selected in the AMC control panel applet (net-
work tab). 

Check that the relevant MPEG-4 connection methods are enabled in the AMC control 
panel applet (network tab). 

In the AMC control applet, select the MPEG-4 tab and click the button Set to default 
MPEG-4 decoder. 

No multicast MPEG-4 displayed in 
the client

Check with your network administrator that the multicast addresses used by the  
camera are valid for your network.

Check with your network administrator to see if there is a firewall preventing viewing.

Multicast MPEG-4 only accessible by 
local clients

Check if your router supports multicasting, or if the router settings between the client and 
the server need to be configured. The TTL (Time To Live) value may need to be increased.
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Poor rendering of MPEG-4 images Color depth set incorrectly on clients. Set to 16-bit or 32-bit color.

If text overlays are blurred, or if there are other rendering problems, you may need to 
enable Advanced Video Rendering from the MPEG-4 tab in the AMC control panel applet.

Ensure that your graphics card is using the latest device driver. The latest drivers can usu-
ally be downloaded from the manufacturer's web site. 

Color saturation is different in 
MPEG-4 and Motion JPEG

Modify the settings for your graphics adapter. Please see the adapter's documentation for 
more information.

Lower frame rate than expected Reduce number of applications running on the client computer.

Limit the number of simultaneous viewers. This is done in System Options > Security > 
Users.
Check with the system administrator that there is enough bandwidth available. See also 
the online help.

Check in the AMC control panel applet (MPEG-4 tab) that video processing is not set to 
Decode only I frames.
Lower the image resolution.

Why do I not get 30 frames per second? See the section General performance considerations, on page 61.

Lost or poor images in pre-trigger 
buffer (MPEG-4 video stream)

Make sure that Cyclic refresh under Setup > Video & Image > Advanced > MPEG-4  
is disabled.

Image degeneration Decrease the GOV length, see the online help for more information.

The Power indicator is not constantly lit
Faulty power supply Check that you are using an AXIS PS-L power supply. 

The Status and Network indicator LEDs are flashing red rapidly
Hardware failure Contact your Axis dealer. 

The Status indicator LED is flashing red and the camera is inaccessible
A firmware upgrade has been inter-
rupted or the firmware has otherwise 
been damaged

See the Emergency Recovery Procedure above. 

No images displayed on web page
Problem with AMC.  
(Internet Explorer only)

To enable the updating of video images in Microsoft Internet Explorer, set your browser to 
allow ActiveX controls. Also, make sure that AXIS Media Control (AMC) component is 
installed on your workstation. 

Installation of additional ActiveX 
component restricted or prohibited

Configure your camera to use a Java applet for updating the video images under 
Live View Config > Layout > Default Viewer for Internet Explorer. See the online help for 
more information.

Video/Image problems, general
Image too dark or too light Check the video image settings. See the online help on Video and Image Settings.

Missing images in uploads This can occur when trying to use a larger image buffer than is actually available. Try low-
ering the frame rate or the upload period.

Slow image update Configuring, e.g. pre-buffers, motion detection, high-resolution images, high frame rates, 
etc, will reduce the performance of the camera. 

Poor performance Poor performance may be caused by e.g. heavy network traffic, multiple users accessing 
the unit, low performance clients, use of features such as Motion Detection, Event han-
dling, Image rotation other than 180 degrees.

Poor quality snapshot images
Screen incorrectly configured on your 
workstation

In Display Properties, configure your screen to show at least 65000 colors, i.e. at least 
16-bit. Using only 16 or 256 colors will produce dithering artifacts in the image. 
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For further assistance, please contact your reseller or see the support pages on the Axis 
Website at www.axis.com/techsup

Overlay/Privacy mask is not displayed
Incorrect size or location of overlay or 
privacy mask.

The overlay or privacy mask may have been positioned incorrectly or wrong resolution was 
used while positioning. Refer to the online help for information on the limitations when 
using image overlays and privacy masks. 

Browser freezes
Netscape 7.x or Mozilla 1.4 (or later) 
can sometimes freeze on a slow com-
puter

Lower the image resolution. 

Problems uploading files
Limited space There is only limited space available for the upload of your own files. Try deleting existing 

files to free up space.

Motion Detection triggers unexpectedly
Changes in luminance Motion detection is based upon changes in luminance in the image. This means that if 

there are sudden changes in the lighting, motion detection may be triggered mistakenly. 
Lower the sensitivity setting to avoid problems with luminance.

No audio 
 Incorrect setup Check the sound card in the PC. Ensure that the mute button is not pressed and the volume 

settings are correct.

No audio or 
very poor audio quality

Check that the correct Audio Input source is selected under Setup > Audio > Source. Select 
Microphone for the internal microphone or for a connected external microphone. Select 
Line for a connected line in source.

Audio volume too low/high
Volume settings incorrect The volume of the microphone is either too high or too low. Change the volume for the 

microphone in the toolbar on the Live View page. 

Poor audio quality
Too many users Too many users/clients connected to the camera may affect the sound quality adversely. 

Try limiting the number of clients allowed to connect under Basic Configuration > Users.
CPU overloaded Reduce the number of listeners and viewers and decrease the image resolution and com-

pression.

Unsynchronized audio and video It is recommended that the camera's time setting is synchronized with an NTP Server. This 
is enabled under System Options > Date & Time.

Distorted audio Check that the correct Audio Input source is selected under Setup > Audio > Source. Select 
Microphone for the internal microphone or for a connected external microphone. Select 
Line for a connected line in source.

Stuttering audio Audio break-up (stuttering audio) can be reduced using the Buffer slider control on the 
Live View page. A higher level will reduce audio break-up, but may introduce a noticeable 
lag in audio transmission.
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Technical Specifications - AXIS 216FD/216FD-V

Item Specification

Models • AXIS 216FD: Tamper-resistant casing
• AXIS 216FD-V: Vandal-resistant casing

Image sensor ¼” Micron progressive scan RGB CMOS

Lens • Fujinon, F1.3 varifocal 2.8-10mm
• DC-iris
• Focus range: 0.3m to infinity

Angle of view AXIS 216FD: Horizontal: 73°-20°

Camera angle 
adjustment

• Pan: 360°
• Tilt: 170°
• Rotation: 340°

Minimum 
illumination

1 lux, F1.3

Video compression • Motion JPEG
• MPEG-4 Part 2 (ISO/IEC 14496-2) with motion estimation 
• Profiles: Advanced Simple Profile and Simple Profile

Resolutions • 9 resolutions from 640x480 to 160x120 via API 
• 6 selections via configuration web page

Frame rate • Up to 30 fps in all resolutions (Motion JPEG or MPEG-4)

Video streaming • Simultaneous Motion JPEG and MPEG-4
• Controllable frame rate and bandwidth
• Constant and variable bit rate (MPEG-4)

Image settings • Compression levels: 100
• Rotation: 0º, 180º
• Configurable color level, brightness, sharpness, contrast, white balance, exposure control
• Overlay capabilities: time, date, text, image or privacy mask

Shutter time 1/4 s to 1/15000 s

Audio • Configurable for built-in or external microphone
• Audio compression 

- Audio in: AAC LC 8-32 kbit/s, G.711 PCM 64 kbit/s, G.726 ADPCM 32 or 24 kbit/s 
- Audio out: G.711 PCM 64 kbit/s, G.726 ADPCM 32 or 24 kbit/s

• Half duplex, simplex or audio off
• Audio alarm at configurable detection level

Security • Multiple user access levels with password protection
• IP address filtering
• HTTPS encryption
• Network control IEEE 802.1X

Users • 20 simultaneous users
• Unlimited number of users using multicast (MPEG-4)

Alarm and event 
management

• Events triggered by built-in multi-window motion detection, audio detection, external 
input, or according to schedule

• Image upload over FTP, email and HTTP 
• Notification over TCP, email, HTTP and external output
• Pre- and post alarm buffer of 9 MB (approx. 5 min of 320x240 resolution video at 4 fps)
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Connectors • Ethernet 10BaseT/100BaseTX, RJ-45 
• Mini DC power jack
• Terminal block for 1 alarm input and 1 output
• 3.5 mm jack for Mic in (max 80 mVpp) or Line mono input (max 6.4 Vpp)
• 3.5 mm jack for Line mono output (max 1.3 Vpp) to active speaker. 
• Input impedance: 2.4k Ω  Output impedance: Min. 16 Ω

Casing • AXIS 216FD: Polycarbonate base and polycarbonate dome glass
• AXIS 216FD-V: 1000 kg (2200 lbs) impact-resistant casing with metal base and rugged 

polycarbonate dome glass
• Tamper-proof mounting on wall, hard or drop ceiling 

Processors, memory, 
clock

• CPU, video processing and compression: ARTPEC-A
• RAM: 32 MB
• Flash memory: 8 MB
• Battery backed-up real-time clock

Power • 4.9-5.1V DC max 3.6W
• Power over Ethernet (IEEE 802.3af) with power classification: Class 1 (max 3.84 W)

Operating conditions • Temperature: 0-50 ºC (32-122 ºF)
• Humidity 20-80% RH (non-condensing)

Installation, 
management and 
maintenance

• AXIS Camera Management tool on CD and web-based configuration
• Configuration of backup and restore
• Firmware upgrades over HTTP or FTP, firmware available at www.axis.com 

Video access from
Web browser

• Camera live view
• Video recording to file (ASF)
• Sequence tour for up to 20 Axis video sources
• Customizable HTML pages 

Minimum web 
browsing 
requirements

• Pentium III CPU 500 MHz or higher or equivalent AMD
• 128 MB RAM
• AGP graphics card, DirectDraw, 32 MB video RAM
• Windows XP, 2000 
• DirectX 9.0 or later 
• Internet Explorer 6.x or later  

For other operating systems and browsers, see www.axis.com/techsup 

System integration 
support 

• Open API for application integration including AXIS VAPIX API*, AXIS Media Control SDK*, 
event trigger data in video stream

• Quality of Service (QoS) Layer 3, DiffServ Model
• Embedded Linux operating system
 
* Available for download at www.axis.com

Supported protocols IPv4/v6, HTTP, HTTPS, SSL/TLS*, TCP, ICMP, QoS, SNMPv1/v2c/v3 (MIB-II), RTSP, RTP, UDP, 
IGMP, RTCP, SMTP, FTP, DHCP, UPnP, ARP, DNS, DynDNS, SOCKS, NTP etc.
More information on protocol usage available at www.axis.com
 
* This product includes software developed by the Open SSL Project for use in the Open SSL 
Tool kit (www.openssl.org) 

Item Specification
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Video management 
software 
(not included)

AXIS Camera Station: Surveillance application for viewing, recording and archiving up to 25 
cameras
See www.axis.com/partner/adp_partners.htm for further software applications from 
partners.

Included accessories • Installation Guide
• CD with User’s Manual, demo software, installation and management tools
• Mounting and connector kits
• Power supply 5.1 V DC
• MPEG-4 licenses (1 encoder, 1 decoder), MPEG-4 decoder (Windows) 

Accessories 
(not included)

• Tamper-resistant casing with smoked dome glass
• Vandal-resistant casing with smoked dome glass
• Drop ceiling mount kit
• MPEG-4 Decoder multi-user license pack

Approvals • EN 55022
• EN61000-3-2
• EN61000-3-3
• EN 55024
• FCC Part 15, Subpart B, Class B 
• ICES-003 Class B
• VCCI Class B)
• C-Tick AS/NZS CISPR22
• EN 60950-1 

• Power supply: EN 60950, UL, CSA

Dimensions (HxWxD) 
& weight

• 94 x 144 x 132 mm (3.7” x 5.7” x 5.2”)
• Weight AXIS 216FD: 425g (0.94 lb) excl. power supply 
• Weight AXIS 216FD-V: 580g (1.28 lb) excl. power supply 

Item Specification
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Technical Specifications - AXIS 216MFD/216MFD-V

Item Specification

Models • AXIS 216MFD: Tamper-resistant casing
• AXIS 216MFD-V: Vandal-resistant casing

Image sensor 1/3” Micron progressive scan RGB 1.3 Megapixel CMOS

Lens • Fujinon, F1.3 varifocal 2.8-10mm
• DC-iris
• Focus range: 0.3m to infinity

Angle of view  Horizontal: 27° - 100°

Camera angle 
adjustment

• Pan: 360°
• Tilt: 170°
• Rotation: 340°

Minimum 
illumination

2 lux, F1.3

Video compression • Motion JPEG
• MPEG-4 Part 2 (ISO/IEC 14496-2) with motion estimation 
• Profiles: Advanced Simple Profile and Simple Profile

Resolutions • 24 resolutions from 1280x1024 to 160x90 via API
• 22 selections via configuration Web page

Frame rate • Motion JPEG: Up to 12 fps at 1280x1024
20 fps at 1024x768 (partial scan) 
30 fps at 800x600 (partial scan)

• MPEG-4: Up to 8 fps at 1280x1024
13 fps at 1024x768 (partial scan) 
20 fps at 800x600 (partial scan)

*Partial scan takes the data from the center region of the sensor and scales it down to 
present an image at optimal frame rate.

Video streaming • Simultaneous Motion JPEG and MPEG-4
• Controllable frame rate and bandwidth
• Constant and variable bit rate (MPEG-4)

Image settings • Compression levels: 100
• Rotation: 0º, 180º
• Configurable color level, brightness, sharpness, contrast, white balance, exposure control, 

fine tuning of behavior at low light
• Overlay capabilities: time, date, text, image or privacy mask

Shutter time 1/4 s to 1/15000 s

Audio • Configurable for built-in or external microphone
• Audio compression 

- Audio in: AAC LC 8-32 kbit/s, G.711 PCM 64 kbit/s, G.726 ADPCM 32 or 24 kbit/s 
- Audio out: G.711 PCM 64 kbit/s

• Half duplex, simplex or audio off
• Audio alarm at configurable detection level
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Security • Multiple user access levels with password protection
• IP address filtering
• HTTPS encryption
• Network access control IEEE 802.1X

Users • 20 simultaneous users
• Unlimited number of users using multicast (MPEG-4)

Alarm and event 
management

• Events triggered by built-in multi-window motion detection, external input, audio 
detection or according to schedule

• Image upload over FTP, email and HTTP 
• Notification over TCP, email, HTTP and external output
• Pre- and post alarm buffer of 20 MB (250 images or more, in full 1280x1024 resolution)

Connectors • Ethernet 10BaseT/100BaseTX, RJ-45 
• Mini DC power jack
• Terminal block for 1 alarm input and 1 output
• 3.5 mm jack for Mic in (max 80 mVpp) or Line mono input (max 6.4 Vpp)
• 3.5 mm jack for Line mono output (max 1.3 Vpp) to active speaker. 
• Input impedance: 7.4k Ω  Output impedance: Min. 90 Ω

Casing • AXIS 216MFD: Polycarbonate base and polycarbonate transparent dome glass
• AXIS 216FD-V: 1000 kg (2200 lbs) impact-resistant casing with metal base and rugged 

polycarbonate dome glass
• Tamper-proof mounting on wall, hard or drop ceiling 

Processors, memory, 
clock

• CPU, video processing and compression: ARTPEC-A
• RAM: 64 MB
• Flash memory: 8 MB
• Battery backed-up real-time clock

Power • 4.9-5.1V DC max 3.8W
• Power over Ethernet (IEEE 802.3af) with power classification: Class 1 (max 3.84 W)

Operating conditions • Temperature: 0-50 ºC (32-122 ºF)
• Humidity 20-80% RH (non-condensing)

Installation, 
management and 
maintenance

• AXIS Camera Management tool on CD and web-based configuration
• Configuration of backup and restore
• Firmware upgrades over HTTP or FTP, firmware available at www.axis.com 

Video access from
Web browser

• Camera live view
• Video recording to file (ASF)
• Sequence tour for up to 20 Axis video sources
• Customizable HTML pages 

Minimum web 
browsing 
requirements

• Pentium III CPU 500 MHz or higher or equivalent AMD
• 128 MB RAM
• AGP graphics card, DirectDraw, 32 MB video RAM
• Windows XP, 2000 
• DirectX 9.0 or later 
• Internet Explorer 6.x or later  

For other operating systems and browsers, see www.axis.com/techsup 

Item Specification
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System integration 
support 

• Open API for application integration including AXIS VAPIX API*, AXIS Media Control SDK*, 
event trigger data in video stream

• Quality of Service (QoS) Layer 3, DiffServ Model
• Embedded Linux operating system
 
* Available for download at www.axis.com

Supported protocols IPv4/v6, HTTP, HTTPS, SSL/TLS*, TCP, ICMP, QoS, SNMPv1/v2c/v3 (MIB-II), RTSP, RTP, UDP, 
IGMP, RTCP, SMTP, FTP, DHCP, UPnP, ARP, DNS, DynDNS, SOCKS, NTP etc.
More information on protocol usage available at www.axis.com
 
* This product includes software developed by the Open SSL Project for use in the Open SSL 
Tool kit (www.openssl.org) 

Video management 
software 
(not included)

AXIS Camera Station: Surveillance application for viewing, recording and archiving up to 25 
cameras
See www.axis.com/partner/adp_partners.htm for further software applications from 
partners.

Included accessories • Installation Guide
• CD with User’s Manual, demo software, installation and management tools
• Mounting and connector kits
• Power supply 5.1 V DC
• MPEG-4 licenses (1 encoder, 1 decoder), MPEG-4 decoder (Windows) 

Accessories 
(not included)

• Tamper-resistant casing with smoked transparent dome glass
• Vandal-resistant casing with smoked transparent dome glass
• Drop ceiling mount kit
• MPEG-4 Decoder multi-user license pack

Approvals • EN 55022 Class B
• EN61000-3-2
• EN61000-3-3
• EN 55024
• FCC Part 15, Subpart B, Class B
• ICES-003 Class B
• VCCI Class B
• C-Tick AS/NZS CISPR22 
• EN 60950 

 
Power supply: EN 60950, UL, CSA

Dimensions (HxWxD) 
& weight

• 94 x 144 x 132 mm (3.7” x 5.7” x 5.2”)
• Weight AXIS 216MFD: 425g (0.94 lb) excl. power supply 
• Weight AXIS 216MFD-V: 580g (1.28 lb) excl. power supply 
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General performance considerations
When setting up your system, it is important to consider how various settings and 
situations will affect performance. Some factors affect the amount of bandwidth (the bit 
rate) required, others can affect the frame rate, and some will affect both. If the load on the 
CPU reaches its maximum, this will also affect the frame rate.

The following factors are among the most important to consider:

• High image resolutions and/or lower compression levels result in larger images. 
Bandwidth affected. 

• Access by large numbers of Motion JPEG and/or unicast MPEG-4 clients. Band-
width affected.

• Simultaneous viewing of different streams (resolution, compression, etc.) by dif-
ferent clients. Frame rate and bandwidth affected.

• Accessing both Motion JPEG and MPEG-4 video streams simultaneously. Frame 
rate and bandwidth affected.

• Heavy usage of event settings affects the camera’s CPU load. Frame rate affected.
• Enabled motion detection. Frame rate and bandwidth affected.
• Heavy network utilization due to poor infrastructure. Bandwidth affected
• Viewing on poorly performing client PC’s lowers perceived performance. Frame 

rate affected.

Optimizing your system

To see the bandwidth and frame rate currently required by the video stream, the  
AXIS 216FD/FD-V/MFD/MFD-V provides a tool that can be used to display these values 
directly in the video image.

To do this, special format strings are added as part 
of a text overlay. Simply add #r (average frame 
rate in fps) and/or #b (average bandwidth in kbps) 
to the overlay. 

For detailed instructions, please see the online help 
for Video & Image > Text Overlay Settings, and the help for File Naming & Date/Time 
Formats.

Important!
•The figures displayed here are the values as delivered by the camera. If other restrictions are 

currently in force, (e.g. bandwidth limitation) these values might not correspond to those actu-
ally received by the client.

•For Motion JPEG, these values will be accurate as long as no frame rate limit has been specified.
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Bandwidth
As there are many factors that affect bandwidth, it is very difficult to predict the required 
amounts. The settings that affect bandwidth are:

• image resolution
• image compression
• frame rate
• MPEG-4 GOV settings
• bit rate control settings

There are also factors in the monitored scene that will affect the bandwidth. These are: 

• amount of motion
• image complexity
• lighting conditions

For MPEG-4, if there is only limited bandwidth available, and if this is more important 
than the image quality, using a constant bit rate (CBR) is recommended. Use a variable bit 
rate (VBR) if the image quality needs to be maintained at a higher level. If supported on the 
network, consider also using MPEG-4 multicasting, as the bandwidth consumption will be 
much lower.
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Glossary of Terms
ActiveX - A standard that enables software components to 
interact with one another in a networked environment, 
regardless of the language(s) used to create them. Web 
browsers may come into contact with ActiveX controls, 
ActiveX documents, and ActiveX scripts. ActiveX controls 
are often downloaded and installed automatically as 
required. 

AF (Autofocus) - A system by which the camera lens 
automatically focuses on a selected part of the subject. 

Angle - The field of view, relative to a standard lens in a 
35mm still camera, expressed in degrees, e.g. 30°. For 
practical purposes, this is the area that a lens can cover, 
where the angle of view is determined by the focal length of 
the lens. A wide-angle lens has a short focal length and 
covers a wider angle of view than standard or telephoto 
lenses, which have longer focal lengths.

ARP (Address Resolution Protocol) - This protocol is used 
to associate an IP address to a hardware MAC address. A 
request is broadcast on the local network to discover the 
MAC address for an IP address.

ARTPEC (Axis Real Time Picture Encoder) - This chip is 
used for image compression.

ASIC (Application Specific Integrated Circuit) - A circuit 
designed for a specific application, as opposed to a general 
purpose circuit, such as a microprocessor. 

Aspect ratio - A ratio of width to height in images. A 
common aspect ratio used for television screens and 
computer monitors is 4:3. High-definition television (HDTV) 
uses an aspect ratio of 9:16.

Autoiris (or DC-Iris) - This special type of iris is electrically 
controlled by the camera, to automatically regulate the 
amount of light allowed to enter.

AVI (Audio Video Interleave) - A video format that 
supports simultaneous playback of audio and video. 

Bitmap - A bitmap is a data file representing a rectangular 
grid of pixels. It defines a display space and color for each 
pixel (or "bit") in the display space. This type of image is 
known as a "raster graphic." GIF's and JPEG's are examples 
of image file types that contain bitmaps. 

Because a bitmap uses this fixed raster method, it cannot 
easily be rescaled without losing definition. Conversely, a 
vector graphic image uses geometrical shapes to represent 
the image, and can thus be quickly rescaled. 

Bit rate - The bit rate (in kbit/s or Mbit/s) is often referred 
to as speed, but actually defines the number of bits/time 
unit and not distance/time unit. 

Bluetooth - Bluetooth is an open standard for wireless 
transmission of voice and data between mobile devices (PCs, 
handheld computers, telephones and printers).

Bonjour - Also known as zero-configuration networking, 
Bonjour enables devices to automatically discover each 
other on a network, without having to enter IP addresses or 
configure DNS servers. Bonjour is a trademark of Apple 
Computer, Inc..

Broadband - In network engineering terms, this describes 
transmission methods where two or more signals share the 
same carrier. In more popular terminology, broadband is 
taken to mean high-speed data transmission. 

CCD (Charged Coupled Device) - This light-sensitive image 
device used in many digital cameras is a large integrated 
circuit that contains hundreds of thousands of photo-sites 
(pixels) that convert light energy into electronic signals. Its 
size is measured diagonally and can be 1/4", 1/3", 1/2" or 
2/3". 

CGI (Common Gateway Interface) - A specification for 
communication between a web server and other (CGI) 
programs. For example, a HTML page that contains a form 
might use a CGI program to process the form data once it is 
submitted.

CIF (Common Intermediate Format) - CIF refers to the 
analog video resolutions 352x288 pixels (PAL) and 352x240 
pixels (NTSC). See also Resolution.

Client/Server - Client/server describes the relationship 
between two computer programs in which one program, the 
client, makes a service request from another program, the 
server, which fulfils the request. Typically, multiple client 
programs share the services of a common server program. A 
web browser is a client program that requests services (the 
sending of web pages or files) from a web server.

CMOS (Complementary Metal Oxide Semiconductor) - A 
CMOS is a widely used type of semiconductor that uses both 
negative and positive circuits. Since only one of the circuit 
types is on at any given time, CMOS chips require less 
power than chips using just one type of transistor. CMOS 
image sensors also allow processing circuits to be included 
on the same chip, an advantage not possible with CCD 
sensors, which are also much more expensive to produce.

Codec - In communications engineering, a codec is usually 
a coder/decoder. Codecs are used in integrated circuits or 
chips that convert e.g. analog video and audio signals into a 
digital format for transmission. The codec also converts 
received digital signals back into analog format. A codec 
uses analog-to-digital conversion and digital-to-analog 
conversion in the same chip. 

Codec can also mean compression/decompression, in which 
case it is generally taken to mean an algorithm or computer 
program for reducing the size of large files and programs.

Compression - See Image Compression.

Contrast  - Defines the degree of difference between the 
lightest and darkest parts of an image or video stream.

DC-Iris - This special type of iris is electrically controlled 
by the camera, to automatically regulate the amount of light 
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allowed to enter.

DHCP (Dynamic Host Configuration Protocol) - DHCP is a 
protocol that lets network administrators automate and 
centrally manage the assignment of Internet Protocol (IP) 
addresses to network devices in a network. 

DHCP uses the concept of a "lease" or amount of time that a 
given IP address will be valid for a computer. The lease time 
can vary, depending on how long a user is likely to require 
the network connection at a particular location. 

DHCP also supports static addresses for e.g. computers 
running web servers, which need a permanent IP address.

DNS (Domain Name System) - DNS is used to locate and 
translate Internet domain names into IP (Internet Protocol) 
addresses. A domain name is a meaningful and 
easy-to-remember name for an Internet address. For 
example the domain name www.example.com is much 
easier to remember than 192.0.34.166. The translation tables 
for domain names are contained in Domain name servers.

Domain Server - Domains can also be used by 
organizations who wish to centralize the management of 
their (Windows) computers. Each user within a domain has 
an account that usually allows them to log in to and use any 
computer in the domain, although restrictions may also 
apply. The domain server is the server that authenticates the 
users on the network. 

Duplex - See Full-duplex.

Ethernet - Ethernet is the most widely installed local area 
network technology. An Ethernet LAN typically uses special 
grades of twisted pair wires. The most commonly installed 
Ethernet systems are 10BASE-T and 100BASE-T10, which 
provide transmission speeds up to 10 Mbps and 100 Mbps 
respectively. 

ETRAX (Ethernet Token Ring AXIS) - Axis' own 
microprocessor.

Factory default settings - These are the settings that 
originally applied for a device when it was first delivered 
from the factory. If it should become necessary to reset a 
device to its factory default settings, this will, for many 
devices, completely reset any settings that were changed by 
the user. 

Firewall - A firewall works as a barrier between networks, 
e.g. between a Local Area Network and the Internet. The 
firewall ensures that only authorized users are allowed to 
access the one network from the other. A firewall can be 
software running on a computer, or it can be a standalone 
hardware device. 

Focal length  - Measured in millimeters, the focal length of 
a camera lens determines the width of the horizontal field of 
view, which in turn is measured in degrees.

FTP (File Transfer Protocol) - An application protocol that 
uses the TCP/IP protocols. It is used to exchange files 
between computers/devices on networks. 

Frame - A frame is a complete video image. In the 2:1 
interlaced scanning format of the RS-170 and CCIR formats, 
a frame is made up of two separate fields of 262.5 or 312.5 
lines interlaced at 60 or 50 Hz to form a complete frame, 
which appears at 30 or 25 Hz. In video cameras with a 
progressive scan, each frame is scanned line-by-line and not 
interlaced; most are also displayed at 30 and 25 Hz.

Frame rate - The frame rate used to describe the frequency 
at which a video stream is updated is measured in frames 
per second (fps). A higher frame rate is advantageous when 
there is movement in the video stream, as it maintains 
image quality throughout.

Full-duplex - Transmission of data in two directions 
simultaneously. In an audio system this would describe e.g. 
a telephone systems. Half-duplex also provides 
bi-directional communication, but only in one direction at a 
time, as in a walkie-talkie system. See also Simplex.

Gain - Gain is the amplification factor and the extent to 
which an analog amplifier boosts the strength of a signal. 
Amplification factors are usually expressed in terms of 
power. The decibel (dB) is the most common way of 
quantifying the gain of an amplifier. 

Gateway - A gateway is a point in a network that acts as an 
entry point to another network. In a corporate network for 
example, a computer server acting as a gateway often also 
acts as a proxy server and a firewall server. A gateway is 
often associated with both a router, which knows where to 
direct a given packet of data that arrives at the gateway, and 
a switch, which furnishes the actual path in and out of the 
gateway for a given packet.

GIF (Graphics Interchange Format) - GIF is one of the 
most common file formats used for images in web pages. 
There are two versions of the format, 87a and 89a. Version 
89a supports animations, i.e. a short sequence of images 
within a single GIF file. A GIF89a can also be specified for 
interlaced presentation.

GOV (Group Of VOPs) - A group of VOP's is the basic unit 
of an MPEG-4 video stream. The GOV contains different 
types and numbers of VOP's (I-VOP's, P-VOP's, etc) as 
determined by the GOV length and GOV structure. See also 
VOP.

GOV length - The GOV length determines the number of 
images (VOP's) in the GOV structure. See also GOV and 
VOP.

GOV structure - The GOV structure describes the 
composition of an MPEG-4 video stream, as regards the type 
of images (I-VOP's or P-VOP's) included in the stream, and 
their internal order. See also GOV and VOP.

Half-duplex - See Full-duplex. 

HTML (Hypertext Markup Language) - HTML is the set of 
"markup" symbols or codes inserted in a file intended for 
display in web browser. The markup tells the browser how 
to display the page's words and images for the user.
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HTTP (Hypertext Transfer Protocol) - HTTP is the set of 
rules for exchanging files (text, graphic images, sound, 
video, and other multimedia files) on the web. The HTTP 
protocol runs on top of the TCP/IP suite of protocols.

Hub - A (network) hub is used to connect multiple devices 
to the network. The hub transmits all data to all devices 
connected to it, whereas a switch will only transmit the data 
to the device it is specifically intended for.

IEEE 802.11 - A family of standards for wireless LANs. The 
802.11 standard supports 1 or 2 Mbit/s transmission on the 
2.4 GHz band. IEEE 802.11b specifies an 11 Mbit/s data rate 
on the 2.4 GHz band, while 802.11a allows up to 54 Mbit/s 
on the 5 GHz band.

Image compression - Image compression minimizes the file 
size (in bytes) of an image. Two of the most common 
compressed image formats are JPEG and GIF.

Interlacing - Interlaced video is video captured at 50 
pictures (known as fields) per second, of which every 2 
consecutive fields (at half height) are then combined into 1 
frame. Interlacing was developed many years ago for the 
analog TV world and is still used widely today. It provides 
good  results when viewing motion in standard TV pictures, 
although there is always some degree of distortion in the 
image.

To view interlaced video on e.g. a computer monitor, the 
video must first be de-interlaced, to produce progressive 
video, which consists of complete images, one after the 
other, at 25 frames per second. See also Progressive scan. 

IP (Internet Protocol) - The Internet Protocol is a method 
transmitting data over a network. Data to be sent is divided 
into individual and completely independent "packets." Each 
computer (or host) on the Internet has at least one address 
that uniquely identifies it from all others, and each data 
packet contains both the sender's address and the receiver's 
address. 

The Internet Protocol ensures that the data packets all arrive 
at the intended address. As IP is a connectionless protocol, 
which means that there is no established connection 
between the communication end-points, packets can be sent 
via different routes and do not need to arrive at the 
destination in the correct order. 

Once the data packets have arrived at the correct 
destination, another protocol -  Transmission Control 
Protocol (TCP) - puts them in the right order. See also TCP.

IP Address - An IP address is simply an address on an IP 
network used by a computer/device connected to that 
network. IP addresses allow all the connected 
computers/devices to find each other and to pass data back 
and forth. 

To avoid conflicts, each IP address on any given network 
must be unique. An IP address can be assigned as fixed, so 
that it does not change, or it can be assigned dynamically 
(and automatically) by DHCP. 

An IP address consists of four groups (or quads) of decimal 
digits separated by periods, e.g. 130.5.5.25. Different parts 
of the address represent different things. Some part will 
represent the network number or address, and some other 
part will represent the local machine address. 

See also IP (Internet Protocol).

I-VOP - See VOP.

JPEG (Joint Photographic Experts Group) - Together with 
the GIF file format, JPEG is an image file type commonly 
used on the web. A JPEG image is a bitmap, and usually has 
the file suffix '.jpg' or ".jpeg." When creating a JPEG image, 
it is possible to configure the level of compression to use. As 
the lowest compression (i.e. the highest quality) results in 
the largest file, there is a trade-off between image quality 
and file size. 

kbit/s (kilobits per second) - A measure of the bit rate, i.e. 
the rate at which bits are passing a given point. See also Bit 
rate.

LAN (Local Area Network) - A LAN is a group of 
computers and associated devices that typically share 
common resources within a limited geographical area.

Linux - Linux is an open source operating system within 
the Unix family. Because of its robustness and availability, 
Linux has won popularity in the open source community 
and among commercial application developers.

MAC address (Media Access Control address) - A MAC 
address is a unique identifier associated with a piece of 
networking equipment, or more specifically, its interface 
with the network. For example, the network card in a 
computer has its own MAC address. 

Manual iris - This is the opposite to an autoiris, i.e. the 
camera iris must be adjusted manually to regulate the 
amount of light allowed to reach the image sensor.

Mbit/s (Megabits per second) - A measure of the bit rate, 
i.e. the rate at which bits are passing a given point. 
Commonly used to give the "speed" of a network. A LAN 
might run at 10 or 100 Mbit/s. See also Bit rate.

Monitor - A monitor is very similar to a standard television 
set, but lacks the electronics to pick up regular television 
signals.

Motion JPEG - Motion JPEG is a simple 
compression/decompression technique for networked video. 
Latency is low and image quality is guaranteed, regardless 
of movement or complexity of the image. Image quality is 
controlled by adjusting the compression level, which in turn 
provides control over the file size, and thereby the bit rate. 

High-quality individual images from the Motion JPEG 
stream are easily extracted. See also JPEG.

Megapixel - See Pixel.

MPEG (Moving Picture Experts Group) -  The Moving 
Picture Experts Group develops standards for digital video 
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and audio compression. It operates under the auspices of the 
International Organization for Standardization (ISO). The 
MPEG standards are an evolving series, each designed for a 
different purpose.

MPEG-2 - MPEG-2 is the designation for a group of audio 
and video coding standards, and is typically used to encode 
audio and video for broadcast signals, including digital 
satellite and Cable TV. MPEG-2, with some modifications, is 
also the coding format used by standard commercial DVD 
movies.

MPEG-4 - MPEG-4 is a group of audio and video coding 
standards and related technology. The primary uses for the 
MPEG-4 standard are web (streaming media) and CD 
distribution, conversational (videophone), and broadcast 
television.

Most of the features included in MPEG-4 are left to 
individual developers to decide whether to implement them 
or not. This means that there are probably no complete 
implementations of the entire MPEG-4 set of standards. To 
deal with this, the standard includes the concept of 
"profiles" and "levels", allowing a specific set of capabilities 
to be defined in a manner appropriate for a subset of 
applications.

Multicast - Bandwidth-conserving technology that reduces 
bandwidth usage by simultaneously delivering a single 
stream of information to multiple network recipients. 

Multiplexer - A multiplexer is a high-speed switch that 
provides full-screen images from up to 16 analog cameras. 
Multiplexers can playback everything that happened on any 
one camera with no interference from the other cameras on 
the system.

Network connectivity - The physical (wired or wireless) 
and logical (protocol) connection of a computer network or 
an individual device to a network, such as the Internet or a 
LAN.

NTSC (National Television System Committee) - NTSC is 
the television and video standard in the United States. NTSC 
delivers 525 lines at 60 half-frames/second.

OEM (Original Equipment Manufacturer) - This is a 
designation for companies that manufacture equipment 
which is then marketed and sold to other companies under 
their own names.

PAL (Phase Alternating Line) - PAL is the dominant 
television standard in Europe. PAL delivers 625 lines at 50 
half-frames/second.

PEM (Privacy Enhanced Mail) - An early standard for 
securing electronic mail. The PEM-format is often used for 
representing an HTTPS certificate or certificate request.

Ping  - Ping is a basic network program used diagnostically 
to check the status of a network host or device. Ping can be 
used to see if a particular network address (IP address or 
host name) is occupied or not, or if the host at that address 
is responding normally. Ping can be run from e.g. the 

Windows Command prompt or the command line in Unix.

Pixel - A pixel is one of the many tiny dots that make up a 
digital image. The color and intensity of each pixel 
represents a tiny area of the complete image. 

PoE (Power over Ethernet) - Power over Ethernet provides 
power to a network device via the same cable as used for the 
network connection. This is very useful for IP-Surveillance 
and remote monitoring applications in places where it may 
be too impractical or expensive to power the device from a 
power outlet. 

PPP (Point-to-Point Protocol) - A protocol that uses a 
serial interface for communication between two network 
devices. For example, a PC connected by a phone line to a 
server. 

PPTP (Point-to-Point Tunneling Protocol) - A protocol (set 
of communication rules) that allows corporations to extend 
their own corporate network through private "tunnels" over 
the public Internet. In this way a corporation can effectively 
use a WAN (Wide Area Network) as a large single LAN 
(Local Area Network). This kind of interconnection is known 
as a virtual private network (VPN). 

Pre/post alarm images - The images from immediately 
before and after an alarm. These images are stored in a 
buffer for later retrieval.

Progressive scan - Progressive scan, as opposed to 
interlaced video, scans the entire picture, line by line every 
sixteenth of a second. In other words, captured images are 
not split into separate fields as in interlaced scanning. 

Computer monitors do not need interlace to show the 
picture on the screen, but instead show them progressively, 
on one line at a time in perfect order, i.e. 1, 2, 3, 4, 5, 6, 7 
etc., so there is virtually no "flickering" effect. In a 
surveillance application, this can be critical when viewing 
detail within a moving image, such as a person running. A 
high-quality monitor is required to get the best from 
progressive scan. See also Interlacing.

Protocol - A special set of rules governing how two entities 
will communicate. Protocols are found at many levels of 
communication, and there are hardware protocols and 
software protocols. 

Proxy server - In an organization that uses the Internet, a 
proxy server acts as an intermediary between a workstation 
user and the Internet. This provides security, administrative 
control, and a caching service. Any proxy server associated 
with a gateway server, or part of a gateway server, 
effectively separates the organization’s network from the 
outside network and the local firewall. It is the firewall 
server that protects the network against outside intrusion. 

A proxy server receives requests for Internet services (such 
as web page requests) from many users. If the proxy server 
is also a cache server, it looks in its local cache of previously 
downloaded web pages. If it finds the page, it is returned to 
the user without forwarding the request to the Internet. If 
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the page is not in the cache, the proxy server, acting as a 
client on behalf of the user, uses one of its own IP addresses 
to request the page from another server over the Internet. 
When the requested page is returned, the proxy server 
forwards it to the user that originally requested it. 

P-VOP - See VOP.

Resolution - Image resolution is a measure of how much 
detail a digital image can hold: the greater the resolution, 
the greater the level of detail. Resolution can be specified as 
the number of pixel-columns (width) by the number of 
pixel-rows (height), e.g. 320x240. 

Alternatively, the total number of pixels (usually in 
megapixels) in the image can be used. In analog systems it 
is also common to use other format designations, such as 
CIF, QCIF, 4CIF, etc.

RTCP (Real-Time Control Protocol) - RTCP provides 
support for real-time conferencing of groups of any size 
within an intranet. This support includes source 
identification and support for gateways like audio and video 
bridges as well as multicast-to-unicast translators.

RTCP offers quality-of-service feedback from receivers to 
the multicast group as well as support for the 
synchronization of different media streams. 

RTP (Real-Time Transport Protocol) - RTP is an Internet 
protocol for the transport of real-time data, e.g. audio and 
video. It can be used for media-on-demand as well as 
interactive services such as Internet telephony. 

RTSP (Real Time Streaming Protocol) - RTSP is a control 
protocol, and a starting point for negotiating transports 
such as RTP, multicast and Unicast, and for negotiating 
codecs. 

RTSP can be considered a "remote control" for controlling 
the media stream delivered by a media server. RTSP servers 
typically use RTP as the protocol for the actual transport of 
audio/video data.

Router - A device that determines the next network point to 
which a packet should be forwarded on its way to its final 
destination. A router creates and/or maintains a special 
routing table that stores information on how best to reach 
certain destinations. A router is sometimes included as part 
of a network switch. See also switch.

Server - In general, a server is a computer program that 
provides services to other computer programs in the same or 
other computers. A computer running a server program is 
also frequently referred to as a server. In practice, the server 
may contain any number of server and client programs. A 
web server is the computer program that supplies the 
requested HTML pages or files to the client (browser). 

Sharpness - This is the control of fine detail within a 
picture. This feature was originally introduced into color TV 
sets that used notch filter decoders. This filter took away all 
high frequency detail in the black and white region of the 
picture. The sharpness control attempted to put some of that 

detail back in the picture. Sharpness controls are mostly 
superfluous in today's high-end TVs. The only logical 
requirement for it nowadays is on a VHS machine. 

Simplex - In simplex operation, a network cable or 
communications channel can only send information in one 
direction.

SMTP (Simple Mail Transfer Protocol) - SMTP is used for 
sending and receiving e-mail. However, as it is "simple," it 
is limited in its ability to queue messages at the receiving 
end, and is usually used with one of two other protocols, 
POP3 or IMAP. These other protocols allow the user to save 
messages in a server mailbox and download them 
periodically from the server. 

SMTP authentication is an extension of SMTP, whereby the 
client is required to log into the mail server before or during 
the sending of email. It can be used to allow legitimate users 
to send email while denying the service to unauthorized 
users, such as spammers. 

SNMP (Simple Network Management Protocol) - SNMP 
forms part of the Internet Protocol suite, as defined by the 
Internet Engineering Task Force. The protocol can support 
monitoring of network-attached devices for any conditions 
that warrant administrative attention.

Sockets - Sockets are a method for communication between 
a client program and a server program over a network. A 
socket is defined as "the endpoint in a connection." Sockets 
are created and used with a set of programming requests or 
"function calls" sometimes called the sockets application 
programming interface (API). 

SSL/TSL (Secure Socket Layer/Transport Layer Security)

These two protocols (SSL is succeeded by TSL) are 
cryptographic protocols that provide secure communication 
on a network. SSL is commonly used over HTTP to form 
HTTPS, as used e.g. on the Internet for electronic financial 
transactions. SSL uses public key certificates to verify the 
identity of the server. 

Subnet/subnet mask - A subnet is an identifiably separate 
part of an organization's network. Typically, a subnet may 
represent all the machines at one geographic location, in 
one building, or on the same local area network (LAN). 
Having an organization's network divided into subnets 
allows it to be connected to the Internet with a single shared 
network address.

The subnet mask is the part of the IP address that tells a 
network router how to find the subnet that the data packet 
should be delivered to. Using a subnet mask saves the router 
having to handle the entire 32-bit IP address; it simply looks 
at the bits selected by the mask.

Switch - A switch is a network device that connects 
network segments together, and which selects a path for 
sending a unit of data to its next destination. In general, a 
switch is a simpler and faster mechanism than a router, 
which requires knowledge about the network and how to 
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determine the route. Some switches include the router 
function. See also Router.

TCP (Transmission Control Protocol) - TCP  is used along 
with the Internet Protocol (IP) to transmit data as packets 
between computers over the network. While IP takes care of 
the actual packet delivery, TCP keeps track of the individual 
packets that the communication (e.g. requested a web page 
file) is divided into, and, when all packets have arrived at 
their destination, it reassembles them to re-form the 
complete file.

TCP is a connection-oriented protocol, which means that a 
connection is established between the two end-points and is 
maintained until the data has been successfully exchanged 
between the communicating applications. 

Telnet - Telnet is a simple method with which to access 
another network device, e.g. a computer. The HTTP protocol 
and the FTP protocols allow you to request specific files 
from remote computers, but do not allow you logon as a 
user of that computer. With Telnet, you log on as a regular 
user with whatever privileges you may have been granted 
for specific applications and data residing on that computer.

TVL (TV Lines) - A method of defining resolutions in 
analog video.

UDP (User Datagram Protocol) - UDP is a communications 
protocol that offers limited service for exchanging data in a 
network that uses the Internet Protocol (IP). UDP is an 
alternative to the Transmission Control Protocol (TCP). The 
advantage of UDP is that it is not required to deliver all data 
and may drop network packets when there is e.g. network 
congestion. This is suitable for live video, as there is no 
point in re-transmitting old information that will not be 
displayed anyway.

Unicast - Communication between a single sender and a 
single receiver over a network. A new connection is 
established for each new user. 

URL (Uniform Resource Locator) - An "address" on the 
network.

USB - (Universal Serial Bus) A plug-and-play interface 
between a computer and peripheral devices, e.g. scanners, 
printers, etc.

Varifocal lens - A varifocal lens provides a wide range of 
focal lengths, as opposed to a lens with a fixed focal length, 
which only provides one. 

VPN (Virtual Private Network) - This creates a secure 
"tunnel" between the points within the VPN. Only devices 
with the correct "key" will be able to work within the VPN. 
The VPN network can be within a company LAN (Local Area 
Network), but different sites can also be connected over the 
Internet in a secure way. One common use for VPN is for 
connecting a remote computer to the corporate network, via 
e.g. a direct phone line or via the Internet.

VOP (Video Object Plane) - A VOP is an image frame in an 
MPEG-4 video stream. There are several types of VOP:

- An I-VOP is complete image frame.

- A P-VOP codes the differences between images, as long as 
it is more efficient to do so. Otherwise it codes the whole 
image, which may also be a completely new image. 

WAN (Wide-Area-Network) - Similar to a LAN, but on a 
larger geographical scale. 

W-LAN (Wireless LAN) - A wireless LAN is a wireless local 
area network that uses radio waves as its carrier: where the 
network connections for end-users are wireless. The main 
network structure usually uses cables.

Web server  - A Web server is a program, which allows 
Web browsers to retrieve files from computers connected to 
the Internet. The Web server listens for requests from Web 
browsers and upon receiving a request for a file sends it 
back to the browser.

The primary function of a Web server is to serve pages to 
other remote computers; consequently, it needs to be 
installed on a computer that is permanently connected to 
the Internet. It also controls access to the server whilst 
monitoring and logging server access statistics.

WEP (Wireless Equivalent Privacy) - A wireless security 
protocol, specified in the IEEE 802.11 standard, which is 
designed to provide a wireless local area network (WLAN) 
with a level of security and privacy comparable to that 
usually expected of a wired LAN. Security is at two different 
levels; 40-bit and 128-bit encryption. The higher the bit 
number, the more secure the encryption.

WINS (Windows Internet Naming Service) - Part of the 
Microsoft Windows NT Server, WINS manages the 
association of workstation names and locations with IP 
addresses, without the user or administrator having to be 
involved in each configuration change. 

WPA-PSK (Wi-Fi Protected Access - Pre-Shared Key) - 
This wireless encryption method uses a pre-shared key (PSK) 
for key management. Keys can usually be entered as manual 
hex values, as hexadecimal characters, or as a Passphrase. 
WPA-PSK provides a greater degree of security than WEP.

Zoom lens - A zoom lens can be moved (zoomed) to enlarge 
the view of an object to show more detail. 
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